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NOTICE

Be sure that the user receives this manual before the product is used.

Copying or duplicating this user’s manual in part or in whole is forbidden. 
The information and specifications in this manual are subject to change 
without notice.

Considerable effort has been made to ensure that this manual is free from 
inaccuracies and omissions. If you should find an error or omission, please 
contact the azbil Group.

In no event is Azbil Corporation liable to anyone for any indirect, special or 
consequential damages as a result of using this product.

© 2016 Azbil Corporation All Rights Reserved.

Modbus™ is a trademark and the property of Schneider Electric SE, its sub-
sidiaries and affiliated companies.

IMPORTANT

Hardware Warranty

This product uses a product from Moxa Inc. (dealer for IBS Japan) as its hardware platform. 
For this reason, responsibility for the hardware warranty resides with IBS Japan Co, Ltd.
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Conventions Used in This Manual

■■ The safety precautions explained in the following section aim to prevent injury to the operator and 
others, and to prevent property damage.

 WARNING Warnings are indicated when mishandling this product might 
result in death or serious injury.

 CAUTION Cautions are indicated when mishandling this product might 
result in minor injury to the user, or physical damage to the 
product. 

■■ In describing the product, this manual uses the icons and conventions listed below.

Use caution when handling the product.

The indicated action is prohibited.

Always follow the indicated instructions.

 Handling Precautions:
Handling Precautions indicate items that the user should pay attention to when handling 
this device.

 Note: Notes indicate information that might benefit the user.

(1), (2), (3): Numbers within parentheses indicate steps in a sequence or parts of an explanation.

This indicates the item or page that the user is requested to refer to.

[Next >],  
[Configuration File]

Square brackets indicate a message or button shown on the PC screen.

[Ctrl] key
[S] key

Square brackets also indicate keys on the keyboard.�

[Ctrl]+[S] key Indicates the operation of pressing the [XXX] key on the keyboard while the [XX] key is 
pressed.

>>: Indicates the result of an operation, details displayed on the personal computer or other 
devices, or the state of the device after operation.
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Safety Precautions

 WARNING
Before removing, mounting, or wiring this device, be sure to turn OFF the power to this device 
and all connected devices.  
Otherwise, an electric shock could result.

Be sure to check that this device has been correctly wired before turning on the power.  
Incorrect wiring of this device can lead to hazardous conditions or can damage it.

 CAUTION
Do not allow wire clippings, metal shavings, water, or other foreign objects to enter the housing.  
Otherwise, fire or device failure could result.

Do not touch electrically charged parts such as the power supply terminals.  
There is a danger of electric shock.

Before wiring this device, be sure to disconnect it from the power supply (but disconnection of 
the network cable is not necessary).  
If it is not disconnected from the power, device failure could result.

Wire the device in compliance with established standards and using the specified power 
source and recognized mounting methods.  
Otherwise, electric shock, fire, or malfunction could result.

Make sure that there are no loose connections.  
Loose connections can cause overheating or device failure.

If there is a risk of a power surge caused by lightning, use a surge protector.  
Otherwise, fire or device failure could result.

Use this device within the operating ranges recommended in the specifications (for 
temperature, humidity, etc.).  
Otherwise, fire or device failure could result.

The supplied power adapter is used for configuring settings and doing checks before 
operation only Do not use it for actual operation.

When discarding this device, dispose of it as industrial waste in accordance with local 
regulations.

This device should be handled by a knowledgeable electrician. 

If this device is operated using a method not specified by the manufacturer, the protective 
functions provided by this device may be impaired.

Wipe off any dirt from the device using a soft cloth.  
Do not use thinner, benzene, or other organic solvents or cleansers.

Be sure that any device or equipment which is connected to this device has reinforced 
insulation appropriate for this device's power supply voltage and maximum I/O operating 
voltages.

This product was not designed as a safety device (a device compliant with IEC 61508), and so 
should not be used in safety-related systems.
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The Role of This Manual

A total of two different manuals are available for the NX-MGW. Read them as necessary for your specific require-
ments. If a manual you require is not available, contact the azbil Group or its dealer.

Network Instrumentation Module 
NX-MGW Ethernet Communication Gateway User's Manual 
� Manual No. CP-SP-1401E

This manual.

Personnel who are using the NX-MGW for the first tim e or who are in charge of hardware 
design and/or maintenance of a control panel containing the NX-MGW should read this 
manual thoroughly.

This manual describes the hardware, provides an overview of the NX-MGW and other 
products used with it, explains mounting, wiring, and troubleshooting, and gives hard-
ware specifications.

NX-MGW Ethernet Gateway Network instrumentation Module  
Installation Manual 
� Manual No. CP-UM-5816JE

This manual is supplied with the NX-MGW.

Personnel in charge of design and/or manufacture of a system using the NX-MGW 
should read this manual thoroughly. It describes NX-MGW safety precautions, 
mounting, wiring, and main specifications.

For further information about operation, see this manual.
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Organization of This User's Manual

This manual is organized as follows.

Chapter 1.	 Overview
Overview, model selection guide, part names and functions

Chapter 2.	 Mounting and Wiring
Mounting and wiring

Chapter 3.	 Functions
Features of this device

Chapter 4.	 SLP-MGW Smart Loader Package
Required operations using the Smart Loader Package specially designed for this device.

Chapter 5.	 Settings
Settings required to operate this device.

Chapter 6.	 Device Communication Settings
Configuration of the host devices connected to this device

Chapter 7.	 Specifications
General specifications of this device

Chapter 8.	 Troubleshooting
How to identify the cause of, and take corrective actions for, problems that might 
arise when using this device

Chapter 9.	 Disposal
How to dispose of this device
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Chapter 1.	 Overview
1 - 1 	 Overview and Features

■■ Overview

The NX-MGW Ethernet Communication Gateway is capable of exchanging data 
between host and slave devices over an Ethernet connection without the use of 
programs.

“Host device” refers to a PLC or other device that controls peripheral devices. “Slave 
device” refers to a Network Instrumentation Module made by Azbil or another de-
vice that receives instructions from host devices.

A total of up to 32 host and slave devices can be connected.

Configuration of the NX-MGW can be done using an SLP-MGW Smart Loader 
Package  that is connected to the Ethernet.

■■ Features

•	Easy adoption and management 
Operation can be started immediately using easy parameter setup with the SLP-
MGW. Communication programs do not need to be created.

•	High scalability 
Data areas can be assigned as desired for enabling effective usage of PLC registers 
and other parameters.

•	Management of connected devices 
The NX-MGW can back up and restore configuration settings for connected de-
vices. This reduces the nitial setup work required for device manufacturing or for 
changing the connected devices when performing maintenance.

•	Powerful design support and debugging functions for operation startup 
To resolve on-site problems due to miswiring or incorrect parameter settings, the 
SLP-MGW provides an online monitor showing the actual execution frequency 
for each process and the communication status of each device, as well as commu-
nication error history and other debugging functions.

Host device Slave device

PLC, etc.

SLP-MGW Smart Loader Package

Network Instrumentation Modules (maximum 31 devices)

…

NX-MGW
Ethernet Communication Gateway 

NX-D25N

PWR RUN MOD COM NST FAIL

1ー P Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NX-D25N

PWR RUN MOD COM NST FAIL

1ー P Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NX-D25N

PWR RUN MOD COM NST FAIL

1ー P Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NX-D25N

PWR RUN MOD COM NST FAIL

1ー P Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NST

4321

PWR RUN MOD COM NST FAIL

LINK
/ ACT

NX-CB1N

3

4

2

1

C
B

RESETV-
12-48V

V+ LAN2LAN1

Ready

TX

RX
P1

TX

RX
P2

P1 P2
RS-232/422/485

C
A
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Chapter 1.	 OVERVIEW

1 - 2 	 Model selection table

■■ NX-MGW

Base 
model 

number
Type Ring  

connection

Option Added 
process Description

1 2 3

NX- Network Instrumentation Module
MGW Ethernet Communication Gateway

N Non-ring communications
0 None

00 None
0 None

0 None

■■ Sold separately

Product name/Specifications Model no. Notes

Smart Loader Package SLP-MGWJ90 PC tool
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Chapter 1.	 OVERVIEW

1 - 3 	 Names and Functions of Part

■■ Main unit

■■ Display unit

●● Ready indicator

Status Description
Off Power is off or system is starting up

Lit green Running
Flashing 

green
Slow flash: stopped or initializing 
Rapid flash: stopped due to error

●● P1/P2 indicators (for serial ports 1 and 2, which are not used)

Status Description
Off Serial port 1 or 2 is not sending data

Lit green Serial port 1 or 2 is sending data

RESETV-
12-48V

V+ LAN2LAN1

Ready

TX

RX
P1

TX

RX
P2

P1 P2
RS-232/422/485

LAN1 
(Ethernet 10BASE-T/100BASE-TX)

LAN2 
(Ethernet 10BASE-T/100BASE-TX)

Reset button

Power connector 
12 V to 48V DC

For RS-232C console 
(not used)

Internal SD card slot 
(not used)

Serial port 2 (not used)

Serial port 1 (not used)

Ready

TX

RX
P1

TX

RX
P2

RESETV-
12-48V

V+ LAN2LAN1

Ready

TX

RX
P1

TX

RX
P2

P1 P2
RS-232/422/485
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Chapter 1.	 OVERVIEW

■■ Connector indicators

●● LAN1/LAN2 connector: orange indicator

Status Description
Off Not connected at 10 Mbps
Lit orange Linked up at 10 Mbps
Flashing orange Transmitting at 10 Mbps

●● LAN1/LAN2 connector: green indicator

Status Description
Off Not connected at 100 Mbps

Lit green Connected at 100 Mbps
Flashing green Transmitting at 100 Mbps

■■ Operation unit

●● Reset button

This is used to reset the NX-MGW unit. Press using a pointed object. The reset per-
forms a software-based restart. Each function is restarted in the same state as when 
the power is turned off and on again.

Orange Green
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Chapter 1.	 OVERVIEW

1 - 4 	 Operation Modes

■■ Operation Modes

The device operating modes and how the system changes between them are shown 
below.

System startup

System startup completion

System error

Con�guration read-in complete

Con�guration error

Initializing

Stop due to errorRunning

RUN STOP

System starting up: 	 System is starting up after power-on

Initializing: 	 Settings are being read after system startup

Running: 	 Gateway configuration has been read

Stop mode: 	 Gateway has stopped communication

Run mode: 	 Gateway has started communication

Stopped due to error: ‌�	 System is stopped due to system error or setting error

●● RUN to STOP mode transition: When one of the operations below is executed from the loader

•	Backup device config (backup of device settings) (NX-MGW←Device)

•	Restore device config (restoration of device settings) (NX-MGW→Device)

•	IP address assignment

•	Write gateway config (writing of gateway settings) (PC→NX-MGW)

•	Write setup data (NX-MGW→Device)

●● STOP to RUN mode transition: ‌�When changing from Initializing to Running and when the loader’s 
execution of one of the operations below is completed

•	Backup device config (backup of device settings) (NX-MGW←Device)

•	Restore device config (restoration of device settings) (NX-MGW→Device)

•	IP address assignment

●● Change from Running to Initializing: ‌�When the loader’s execution of one of the operations below is 
completed

•	Write gateway config (PC→NX-MGW)

•	Write setup data (NX-MGW→Device)

•	Gateway program reset



Memo
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Chapter 2.	 Mounting and Wiring
2 - 1 	 Mounting

 WARNING
Before removing, mounting, or wiring the device, be sure to turn OFF the power to the device 
and all connected devices. 
Otherwise, an electric shock could result.

 Caution
Use this device within the operating ranges recommended in the specifications (for temperature, 
humidity, vibration, shock, mounting direction, atmosphere, etc.). 
Otherwise, a fire or device failure could result.

Do not allow wire clippings, metal shavings, water, or other foreign objects to enter the housing. 
Otherwise, a fire or device failure could result.

■■ Mounting location

Do NOT mount the device where it will be exposed to any of the following.

•	Extremely high or low temperatures or high or low humidity outside the specifi-
cation range

•	Sulfide gas or other corrosive gases

•	Dust or oily smoke

•	Direct sunlight, wind, or rain

•	Mechanical vibration or shock outside the specification range

•	High voltage lines, welding machines, or other sources of electrical noise

•	High-voltage ignition devices for boilers, etc. (within 15 meters)

•	Strong magnetic fields

•	Flammable liquid or gas

•	Outdoor weather

Input/output common mode voltage: Voltage to ground of 30 Vrms max., 42.4V 
peak max., and 60 V DC max.

■■ Mounting methods

This device can be mounted using screws or on a DIN rail.

●● Screw mounting

Secure the device in place using the two screw holes on the right and left.

●● DIN rail mounting

Attach the supplied DIN rail mounting kit (DK-35A) to the screw positions on the 
device, and mount onto the DIN rail. See the external dimensions drawing for the 
mounting dimensions.
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Chapter 2.	 MOUNTING AND WIRING

2 - 2 	 Wiring

 WARNING
Before removing, mounting, or wiring the device, be sure to turn OFF the power to the device 
and all connected devices.  
Otherwise, an electric shock could result.

Be sure to check that the device has been correctly wired before turning on the power.  
Incorrect wiring of this device can lead to hazardous conditions or can damage it.

 Caution
Do not allow wire clippings, metal shavings, water, or other foreign objects to enter the 
housing.  
Otherwise, a fire or device failure could result.

Do not touch electrically charged parts such as the power supply terminals.  
Otherwise, an electric shock could result.

Before wiring this device, be sure to disconnect it from the power supply (but do not disconnect 
the network cable).  
If the power is not disconnected, device failure could result.

Wire the device in compliance with established standards and using the specified power source 
and recognized mounting methods.  
Otherwise, an electric shock, fire or malfunction could result.

Make sure that there are no loose connections.  
Loose connections could cause overheating or device failure.

If there is a risk of a power surge caused by lightning, use a surge protector.  
Otherwise, a fire or device failure could result.

■■ Wiring precautions
•	Make sure that the wiring follows regulations for indoor wiring and technical 

standards for electrical equipment.
•	Do not install wiring outdoors. The equipment could be damaged in the event of 

lightning.
•	Leave a distance of at least 60 cm between the signal wires or power wires of this 

device and the power wires of other equipment. Also, do not pass them through 
the same conduit or wiring duct.

•	When connecting in parallel to another device, check the requirements of the 
other device carefully before installation.

•	When the wiring is completed, check that there are no wiring mistakes before 
turning the power ON.

■■ Power connector

Located on top of the device. It is for supply of 12 V to 48 V DC power. The con-
nector is included.

Connector pin Description

FG     Ground

V- GND     Power supply - side

V+ 12 V – 48 V DC     Power supply + side
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Chapter 2.	 MOUNTING AND WIRING

●● Power connector wiring diagram

RESETV-
12-48V

V+ LAN1

FG - +
12-48 V DC

■■ LAN1 and LAN2 connectors

Located on top of the device. Connect to a cable with an RJ-45 connector. These 
connectors support 10BASE-T and 100BASE-TX Ethernet connections.

For details on connection for Ethernet, 

 1-3, “Explanation of Module Features,” and Chapter 2, “Configuration of 
Ethernet Communications” in the Network Instrumentation Module User’s 
Manual: Network Design Version, No. CP-SP-1313E.

The LAN2 connector uses multiple IP addresses and is set to the fixed IP address 
192.168.255.253. This IP address is used to connect to the SLP-MGW Smart Loader 
Package .

The default values for the IP addresses of each connector are shown below.

IP address default value

LAN1 connector 192.168.0.127
LAN2 connector 192.168.4.127

192.168.255.253

■■ Serial ports 1 and 2

Not used.

Do not connect to these ports.

■■ Internal SD card slot

Not used.

Do not insert anything into this slot.
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Chapter 2.	 MOUNTING AND WIRING

2 - 3 	 System Configuration

The system configuration when using this device is described below.

■■ When the host devices and slave devices are on the same network segment

The LAN1 connector only of this device is used to connect to the host device (PLC) 
and slave devices (Network Instrumentation Modules).

This device, the PLC, Network Instrumentation Modules, and the SLP-MGW are all 
located within the LAN1 network. Set the IP addresses for each device in the LAN1 
network segment.

 Note
•	If the SLP-MGW is connected to the LAN2 connector of this device, use a LAN 

cable to connect the SLP-MGW to the LAN2 connector, and set the SLP-MGW IP 
address within the LAN2 network segment.

PLC, etc.

SLP-MGW

Network Instrumentation Modules

NX-SWA or NX-CB2 (maximum 31 devices) 

192.168.0.2

192.168.0.10～

LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

192.168.0.1

192.168.255.252
NX-MGW

Programmable display unit, etc.

Display
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■■ When there are 17 or more slave devices

A maximum of 31 Network Instrumentation Modules can be connected to this 
device, and a maximum of 16 devices can be connected by a single chain connec-
tion. To connect  more than 16 devices, use a communication adapter (NX-CL1 or 
NX-CR1) to make a chain connection.

Network Instrumentation Modules 

NX-CL1

NX-CR1

…

NX-MGW

3

4

2

1

NX-SWA or NX-CB2 
(max. 31 devices, max. 16 devices in chain connection)

■■ When the host devices and slave devices are on different network segments

The LAN1 and LAN2 connectors of this device are used to connect the host device 
(PLC) and slave devices (Network Instrumentation Modules).

The slave devices are connected to the LAN2 connector, and the other devices are 
connected to the LAN1 connector. Set the IP addresses of the slave devices to the 
same network segment as the LAN2 connector. Set the IP addresses of the other de-
vices to the same network segment as the LAN1 connector.

192.168.255.252
SLP-MGW

SLP-NX

192.168.0.2
Programmable display unit, etc.

PLC, etc.
192.168.0.1

NX-MGW

LAN1=192.168.0.127
LAN2=192.168.4.127 Network Instrumentation Modules

NX-SWA or NX-CB2 (maximum 31 devices)

192.168.4.10̃

Switching hub
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 Note
•	The IP address assignment function can be used even for distributed connections 

up to a maximum of 31 devices where the Network Instrumentation Modules 
are connected to the LAN1 and LAN2 connectors of this device.

■■ When there are 32 or more slave devices

When the number of connected Network Instrumentation Modules exceeds 31, in-
stall two or more NX-MGW units. Set the LAN1 connector of each NX-MGW to the 
same segment as the PLC, and set so that the IP addresses of the LAN1 connectors 
of each NX-MGW are not duplicated. The LAN2 connectors of each NX-MGW are 
used for communication with the Network Instrumentation Modules.

 Note
•	device, communication is also possible when using multiple NX-MGW units if the same 

network segment is used for the Network Instrumentation Modules on the LAN2 side.

192.168.0.200
SLP-MGW

SLP-NX

192.168.0.2
Programmable display unit, etc.

PLC, etc.
192.168.0.1

NX-MGW1
LAN1=192.168.0.127
LAN2=192.168.5.127

Network Instrumentation Modules
192.168.5.10~

Switching hub

RESETV-
12-48V

V+ LAN2LAN1

Ready

TX

RX
P1

TX

RX
P2

P1 P2
RS-232/422/485

1 2

SLP-NX

NX-MGW2
LAN1=192.168.0.128
LAN2=192.168.5.127

Network Instrumentation Modules

31 max.

31 max.

192.168.5.10~
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 Handling Precautions
•	The IP address assignment function cannot be used if an NX-SWA, NX-CB2, or 

other switching hub is used to connect the Network Instrumentation Modules 
using a connection other than a chain connection as shown below.

•	The IP address assignment can be used for distributed connections up to a 
maximum of 31 devices where the Network Instrumentation Modules are con-
nected to the LAN1 and LAN2 connectors of this device.

Network Instrumentation Modules

NX-MGW
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Chapter 3.	 Functions

This chapter describes the functions of the NX-MGW.

■■ Gateway function
The gateway function transmits data between the PLC, which serves as the host 
device, and the Network Instrumentation Modules and other devices, which serve 
as the slave devices. The gateway function includes CyclicTransmit (cyclical data 
transmission), TriggerTransmit (trigger data transmission), and Bit set (bit setting) 
functions.
The gateway function creates transmission settings using the configuration sheet of 
the SLP-MGW Smart Loader Package.
The number of transmission processes is limited for each function. The limits are 
shown in the table below.

Max. sheets Max. processes per sheet Max. total processes in all sheets per 
function

CyclicTransmit 400 sheets 400 lines 4000 lines
TriggerTransmit 400 sheets 400 lines 4000 lines
Bit set 400 sheets 400 lines 4000 lines

●● CyclicTransmit

This function transmits slave device data cyclically to the host device. Host device 
data can also be transmitted to slave devices.
Typical applications:
•	Saving slave device data to the PLC
•	Monitoring of the slave device data by the PLC for device management

Operations by this device in connection with CyclicTransmit are shown below.

PLC

NX-MGW

D0000

D0001

D0002

D0003

M0010

NX-D25

(2) Reading

(1) Cycle start

(3) Writing

(4) Noti�cation

Loop 1 PV
Loop 2 PV
Loop 3 PV
Loop 4 PV

(1) This device starts CyclicTransmit of the configuration sheet at the timing that 
was set for “Cyclic scan-cycle.”

(2) Data is read from the source. If a communication error occurs in the reading 
process, a description of the error is saved in the communication error history, 
and processing of the line where the error occurred in the sheet is stopped.

(3) The data that was read is written to the target device. If a communication error 
occurs in the writing process, a description of the error is saved in the com-
munication error history. The writing process for other lines in the sheet 
continues.

(4) If transfer within the sheet is completed and errors occurs in the execution re-
sults, an error notification is written for each sheet. Next, a completion notifi-
cation is written for each sheet.



3-2

Chapter 3.	 FUNCTIONS

 Note
•	When reading is from a word device and writing is to a bit device, 0 is writ-

ten to the bit device when the word device is 0.  
1 is written to the bit device when the word device is not 0.

The operation of the Cyclic scan-cycle and CyclicTransmit are shown below.

In each cycle, all sheets that are not being executed are started.

Sheets that are still being executed and could not finish in time are executed im-
mediately after completion. Sheets whose completion continues to be delayed are 
executed continuously without a pause.

Cyclic scan-cycle

Cyclic Transmit
Sheet 1

Cyclic Transmit
Sheet 2

Executed continuously if completion continues to be delayed

Processing

Stopped

Processing

Stopped

 Handling Precautions
•	If the cyclic scan-cycle is too short for the amount of data transmission, the 

CyclicTransmit process will continue to be delayed, and ultimately, all sheets 
may be executed continuously rather than cyclically. Even though this is the 
CyclicTransmit function, the execution cycle is slower than the cyclic scan-
cycle setting.

●● TriggerTransmit

Slave device data is transferred to the host device when the change of a trigger de-
vice from OFF to ON is detected. Host device data can also be transmitted to slave 
devices.

Typical applications:

•	Changing the settings of slave devices (SP values, PID settings, etc.) from the PLC

•	Changing the operation of slave devices (switching to RUN, READY, etc.) from 
the PLC
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Operations by this device in connection with TriggerTransmit are shown below.

PLC

NX-MGW

D0000

M0000

D0001

D0002

D0003

M0010

NX-D25(2) Readout

(3) Writing

(1) Trigger ON

(4) Noti�cation

Loop 1SP

Loop 2SP

Loop 3SP

Loop 4SP

Trigger device

(1) This devicemonitors the configuration sheet trigger device for OFF to ON 
changes by reading it at the timing that was set for “Trigger scan-cycle.” 
Transmission by TriggerTransmit is started when a trigger device switches 
from OFF to ON.

(2) Data is read from the source. If a communication error occurs in the reading 
process, a description of the error is saved in the communication error history, 
and processing of the line in the sheet where the error occurred is stopped.

(3) The data that was read is written to the target device. If a communication error 
occurs in the writing process, a description of the error is saved in the com-
munication error history. The writing process for other lines in the sheet 
continues.

(4) If transmission within the sheet is completed and errors occur in the execution 
results, an error notification is written for each sheet. Next, a completion noti-
fication is written for each sheet.

The operation of Trigger scan-cycle and TriggerTransmit are shown below.
All configuration sheets that have detected trigger are started.

Trigger scan-cycle

OFF con�rmation ON con�rmation

Trigger device 
(ON/OFF by PLC)

Trigger Transmit 
Sheet 1

Trigger cannot be detected if PLC ON/OFF occurs too early for trigger scan

ON

OFF

Processing

Stopped
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If "Init trigger device" (trigger device initialization) is set to "Yes," the trigger device 
is turned off immediately after a trigger is detected. If a trigger device was turned 
off by the trigger device initialization function, the situation is identical to confir-
mation by the NX-MGW that the trigger device = OFF, and so trigger detection oc-
curs if trigger device = ON at the next trigger scan cycle.

Trigger scan-cycle

Trigger device initialization

Trigger device

Trigger Transmit 
Sheet 1

Trigger detected after it is turned o� by trigger device initialization function

ON

OFF

Processing

Stopped

OFF con�rmationOFF con�rmationOFF con�rmationOFF con�rmation ON con�rmationON con�rmationON con�rmationON con�rmation

OFF con�rmedOFF con�rmedOFF con�rmedOFF con�rmed

ON con�rmationON con�rmationON con�rmationON con�rmation

 Note
•	When reading is from a word device and writing is to a bit device, 0 is written to 

the bit device when the word device is 0.  
1 is written to the bit device when the word device is not 0.
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●● Bit set

When it is detected that a trigger (write OFF) device or a trigger (write ON) device 
changes from OFF to ON, 0 or 1 is written to the slave device. Specifically, 1 is writ-
ten when a trigger (write ON) is detected, and 0 is written when a trigger (write 
OFF) is detected.

Typical applications:

•	Changing the operation of slave devices (switching to RUN, READY, etc.) from 
the PLC

Operations by this device in connection with Bit set are shown below.

PLC

NX-MGW

M0000

M0010

NX-D25

(2) Write
(1) Trigger ON

(3) Noti�cation

Loop 1 RUN

Loop 2 RUN

Loop 3 RUN

Loop 4 RUN

Trigger device
Trigger device
Trigger device

(1) This device reads, at the timing that was set for "Trigger scan-cycle," the trigger 
(write ON) devices and trigger (write OFF) devices in each line of the configu-
ration sheet to monitor changes from OFF to ON. Bit set is started when a trig-
ger device switches from OFF to ON.

(2) 1 is used for writing to trigger (write ON) devices, and 0 is used for writing to 
trigger (write OFF) devices.

(3) If transmission within the sheet is completed and an error occurs in the execu-
tion results, an error notification is written for each sheet. Next, a completion 
notification is written for each sheet.

The timing of the trigger scan-cycle and trigger detection is identical to that of 
TriggerTransmit.

 Handling Precautions

•	If a trigger (write ON) and trigger (write OFF) are detected simultaneously dur-
ing a single trigger scan, first, 0 is written, and then 1 is written when the next 
process is performed.
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■■ Device management function

The device management function is for maintenance management of connected 
devices.

The device management function includes “Backup Restore,” “IP address assign-
ment,” and “Status Notification” functions.

The device management function creates settings using the SLP-MGW configura-
tion sheet.

 Handling Precautions
•	Azbil’s Network Instrumentation Modules are the only slave devices that sup-

port Backup Restore and IP address assignment for connected devices.

●● Backup Restore

When the change of a backup trigger device from OFF to ON is detected, the con-
figuration file of the slave device is read and saved in this device.

When the change of the restore trigger device from OFF to ON is detected, the con-
figuration file saved in this device is written to the slave device.

Operations by this device in connection with configuration backup are shown 
below.

PLC

NX-MGW

M0000

M0010

NX-D25(2) Reading of
 con�guration �le

(1)Trigger ON

(3) Noti�cation

con�guration �le

Trigger device
Trigger device
Trigger device

(1) This device reads, at the timing that was set for “Trigger scan-cycle,” the con-
figuration backup devices in each line of the configuration sheet  to monitor 
when a device changes from OFF to ON. The configuration backup process is 
started when a trigger device switches from OFF to ON.

(2) The configuration file of the source is read and saved.

(3) If transmission within the sheet is completed and an error occurs in the execu-
tion results, an error notification is written for each sheet. Next, a completion 
notification is written for each sheet.

The timing of the trigger scan-cycle and trigger detection is identical to that of 
Trigger Transmit.
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Operations by this device in connection with configuration restore are shown 
below.

PLC

NX-MGW

M0000

M0010

NX-D25(2) Writing of 
con�guration �le

(1) Trigger ON

(3) Noti�cation

con�guration �le

Trigger device
Trigger device
Trigger device

(1) This device reads the configuration backup devices in each line of the configu-
ration sheet at the timing that was set for “Trigger scan-cycle” to monitor when 
a device changes from OFF to ON. The configuration backup process is started 
when a trigger device switches from OFF to ON.

(2) The configuration file is written to the target device.

(3) When the configuration backup for each line is completed, a results notification 
is written for each line.  
If an error occurs in the execution results, an error notification is written for 
each line.  
Next, a completion notification is written for each line. The results notifica-
tion uses the results codes shown below. If a bit device was specified for results 
notification, 0 is written when the result code is 0, and 1 is written when the 
result is not 0.

Function Result code Meaning
Backup and Restore 
shared codes

0 Normal termination
86 File is corrupted
87 Failed to obtain device version
88 Model number mismatch
89 Unsupported version
90 Unable to read file
91 Failed to connect to device
92 Communication error with device
93 Data receive operation failed

Backup 94 Data save operation failed
Restore 94 Error response received from device

95 Backup file is too large

The timing of the trigger scan-cycle and trigger detection is identical to that of 
TriggerTransmit.

 Handling Precautions

•	An abnormal termination occurs if there is no configuration file for the target 
device in the NX-MGW.

●● Backup All and Restore All
“Backup All Trigger” or “Restore All Trigger” can be set to perform backup or resto-
ration for all registered devices.
These operations are not performed for devices where “Enabled/Disabled” is set to 
“Disabled.”
When execution of Backup All or Restore All is completed, notification is sent to 
devices that were set for “Notify Result,” “Notify Complete,” or “Notify Error” in the 
lines of the configuration sheet. No notification is sent if the setting is blank.
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●● IP address assignment

When a change of the IP address trigger device from OFF to ON is detected, the IP 
address of the slave device is assigned based on the settings.

Operations by this device in connection with assigning IP addresses are shown 
below.

PLC
NX-MGW

M0000

M0010
(3) Noti�cation

(2) Assignment

(1) Trigger ON

NX-D25
NX-D25
NX-D25
NX-D25

Trigger device

Noti�cation device

LAN1/LAN2設定LAN1/LAN2設定

(1) This device reads, at the timing that was set for “Trigger scan-cycle,” the IP ad-
dress trigger device of the configuration sheet to monitor when it switches 
from OFF to ON.  
IP address assignment is started when a trigger device switches from OFF to ON.

(2) An IP address is assigned based on the LAN1/LAN2 configuration sheet.

(3) If transmission within the sheet is completed, a results notification is written for 
each sheet.  
If an error occurs in the execution results, an error notification is written for 
each sheet.  
Next, a completion notification is written for each sheet. The results notifica-
tion uses the results codes shown below. If a bit device was specified for results 
notification, 0 is written when the result code is 0, and 1 is written when the 
result code is not 0.

Result code Meaning

0 Normal termination
86 Too many Network Instrumentation Modules
87 Local IP address does not match
88 Socket error occurred
89 Canceled
91 Number of devices does not match
92 Failed to obtain connected device information
93 Number of devices does not match (device comparison)

The timing of the trigger scan-cycle and trigger detection is identical to that of 
TriggerTransmit.

 Handling Precautions

•	IP addresses cannot be assigned to Network Instrumentation Modules located 
behind a router.  
Use the SLP-NX to set IP addresses for Network Instrumentation Modules be-
hind a router.
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 Note
•	The IP address assignment sets the IP address, subnet mask, default gateway, 

chain name, workgroup ID, and node ID for Network Instrumentation Modules. 
It does not change RS-485 settings or port settings.

•	The values for the subnet mask and default gateway that are set for each Network 
Instrumentation Module by the IP address assignment are the same as the LAN 
settings for the connected NX-MGW.

•	The values for the chain name, workgroup ID, and node ID that are set for each 
Network Instrumentation Module by the IP address assignment are shown below.

•	Chain name: 	 NX GATEWAY

•	Workgroup ID: 	 1

•	Node ID: 	 Sequential number starting from 1 in the assigned order

The relationship between the system configuration and the configuration shown on 
the SLP-MGW screen is shown below.

IP addresses are assigned in order starting from the left side of the physical 
Network Instrumentation Module in the top row.

PLC Network Instrumentation Modules
192.168.0.2
192.168.0.3
192.168.0.4

LAN1=192.168.0.127

192.168.0.1

NX-MGW
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●● Status notification

The status notification function includes “Cyclic ON Notify,” which notifies the host 
device when the NX-MGW is running, and “Notify Connected Status,” which noti-
fies the host device when a slave device is disconnected.

•	Operations by this device in connection with Cyclic ON Notify are shown below.

PLC
NX-MGW

M0010
(1) Notify

Cyclic ON Notify device

(1) This device writes 1 to the Cyclic ON Notify device at the timing set for “Status 
notification interval.”

•	Operations by this device in connection with Notify Connected Status are shown 
below.

PLC
NX-MGW

M0010
(2) Noti�cation

(1) Status is saved if communication 
 was disconnected

NX-D25
NX-D25
NX-D25
NX-D25

Noti�cation device

Stored disconnection status

(1) If a disconnection occurs when this device is communicating with a slave device 
using a gateway function or similar function, the status is saved.

(2) This device writes a value to the Notify Disconnect device at the timing set for 
“Status notification interval.” If the device is connected, “0” is written, and if 
the device is disconnected, “1” is written. If set to “Notify Word,” the value is 
written to the specified bit position.

 Note

•	If “Notify Connected Status” is set to “Notify Word,” a duplicate “Notify 
Disconnect” can be set. In the settings in the example below, if the NX-D15 de-
vices in 1-1 and 1-3 are disconnected, a value of 0005h (hexadecimal) is writ-
ten collectively for the status of the devices to D000000 of the host device.

No. Device Notify Disconnect Bit Position

1-1 NX-D15 (disconnected) D000000 0
1-2 NX-D15 D000000 1
1-3 NX-D15 (disconnected) D000000 2
1-4 NX-D15 D000000 3

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
D000000
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Chapter 4.	 SLP-MGW Smart Loader Package 
4 - 1 	 Overview of SLP-MGW

■■ Functions

The SLP-MGW can write settings to the NX-MGW, read settings, manage connected 
devices, run operation checks, and save data.

■■ System configuration requirements

OS*1 Windows 7 (32-bit/64-bit) 
Windows 8/8.1 (32-bit/64-bit) 
Windows 10 (32-bit/64-bit)

Language*2 Japanese, English*3

CPU 800 MHz or faster
RAM 512 MB or more
Hard disk drive 128 MB or more available space
Display Super VGA (800×600) or higher resolution
CD-ROM drive Required when installing from product CD-ROM disc
Keyboard Required
Mouse Required
LAN port Required when connected to SLP-MGW

*1. Windows XP, Windows Vista, and Server operating systems are not supported.

*2. ‌�Update each OS with the latest service packs and updates before installing this 
product.

*3. I‌�f started in a language environment that is not Japanese, the menus and other infor-
mation are displayed in English.
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4 - 2 	 Installation

■■ Installing the SLP-MGW

Install by following the procedure below.

(1) ARight-click the CD-ROM drive icon to open a pull down menu. From this 
menu, select [Open ].

>> The files and folders on the CD-ROM are displayed.

(2) Double-click the file “setup_slpmgw.msi.”

>> The Setup screen appears. Click the [Next] button on the installer screen.

(3) During the installation process, the End-User License Agreement screen ap-
pears. Check the terms in the license agreement, and if you agree, click “I ac-
cept the terms in the License Agreement” and then click the [Next] button.  
If you do not agree, click [Cancel]. This aborts the installation process.
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(4) Change the default installation folder if necessary.

(5) Once installation preparation is complete, click the [Install] button to start the 
installation process.

(6) The User Account Control screen appears. Select [Yes] to proceed.

>> Installation is started.
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(7) Once installation is complete, click the [Finish] button to close the window.

■■ Uninstalling SLP-MGW

(1) ‌�From the [Control Panel], select [Programs] > [Programs and Features] or 
[Uninstall a program].

(2) Select “SLP-MGW,” and click [Uninstall].

>>SLP-MGW is removed.

 Note
•	Configuration files created by the user will not be removed.
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■■ Upgrade installation and maintenance installation for SLP-MGW

If the SLP-MGW setup file “setup_slpmgw.msi” is executed when the SLP-MGW 
is already installed, instead of a regular new installation, one of the processes de-
scribed below will be performed.

●● Upgrade installation

If setup_slpmgw.msi for a new version of SLP-MGW is executed, the currently in-
stalled version is removed and the new version is installed.

Log data saved by the user is not overwritten.

●● Maintenance installation

If setup_slpmgw.msi for the same version of SLP-MGW is executed, the program 
operates in maintenance installation mode.

•	Repair 
This restores the state immediately after a new installation. It can be used in cases 
of accidental deletion of an executable file, for instance.

•	Remove 
This removes the executable files of the SLP-MGW. Log data saved by the user is 
not deleted.
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4 - 3 	 Starting and Exiting

■■ Starting

The startup procedure for the SLP-MGW is shown below.

(1) Select [Startup Screen] → [View All Apps] → [SLP-MGW].

>> The SLP-MGW starts up, and the main window appears.

 Note
•	By starting the SLP-MGW from the Startup screen, multiple SLP-MGW instances 

can be run simultaneously.  
Running multiple SLP-MGW instances during editing can be useful when copying 
and pasting data.

■■ Exiting

The exit procedure for the SLP-MGW is shown below.

Click the [×] (Close) button on the toolbar. To exit using the menu, select [File] → 
[Exit].

>> This terminates the SLP-MGW.
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4 - 4 	 Operation Sequence

Open Project File

・Open from �le

・Read in from NX-MGW

Create Project File

・Create new project

Startup

Write to NX-MGW Export project �le

・Save �le as...

・Save (overwriting)

Output

Select items to con�gure

・Add new con�guration sheet (BitAlternate)

・Add new con�guration sheet (DataTransmit)

Insert sync point

・Insert sync point (BitAlternate)

・Insert sync point (DataTransmit)

Edit operation

・Direct entry

・Copy and paste

・Select items

・Drag & drop address list 

・Cut/clear

・Insert/delete line (BitAlternate/DataTransmit)

Edit
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4 - 5 	 Main Window

■■ Screen layout

●● Title bar

This shows the configuration file name and program name.

•	When there is no open configuration file, “SLP-MGW” is displayed.

•	When a configuration file is open, “File name” + “-SLP-MGW” is displayed.

•	If the configuration file was read for the first time, “New configuration file - SLP-
MGW” is displayed.

●● Menu

The available items are shown in the menu.

●● Toolbar

This shows buttons associated with the menu items.

●● Project view

This displays the items that can be set for NX-MGW functions in a tree view 
format.

●● Configuration sheet

The configuration sheets for each function are displayed in a list format.

●● Device/parameter selection

Selecting a connected device from the device selection palette opens the “Address 
list,” which allows entry of addresses into the address list palette.

Addresses can be specified easily by simply dragging and dropping addresses from 
the address list palette to the parameter entry field in the configuration view.

●● Information list

An error message appears if an error is found in the settings.

●● Status bar

This shows information on the selected setting.

Menu
Toolbar

Project view

Title bar

Device/
parameter selection

Con�guration sheet

Information list

Status bar
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■■ Menu/Toolbar

The items that can be used in the SLP-MGW appear in the menus and on the 
toolbar.

Item names are based on the rules below.

Icons Functions are displayed as easy-to-understand icons. 
Functions that appear as icons on the toolbar can be executed by click-
ing the icon.

Item names These are the names as they appear in menus.
X This indicates an accelerator key.*1

[Ctrl]+[X] This indicates a shortcut key.*2 
This notation does not appear if there is no corresponding shortcut key.

*1 ‌�An accelerator key refers to a keystroke that enables access to a menu by pressing [Alt] 
+ [specific key]. For example, pressing the [F] key while holding down the [Alt] key 
opens the File menu.

*2 ‌�A shortcut key is a keystroke that enables direct execution of a menu item by press-
ing [Ctrl] (or [Shift]) + [a specific key]. For example, pressing the [C] key while holding 
down the [Ctrl] key executes the [Copy] command in the menu. 

■■ Menu configuration

●● File menu configuration

Menu Icon Submenu Description Shortcut

File Create new project... Creates a new project. [Ctrl]＋[N]

Open Project File... Opens a saved project file (*.mgw). [Ctrl]＋[O]

- Re-open project Up to ten recently opened file names are dis-
played with their full path. Selecting the file 
opens the project file.

-

Save project Saves an opened project to a file. [Ctrl]＋[S]

- Save project as... Names and saves an opened project to a file. -
- Close project Closes an opened project file. -
- Export... Exports the settings for an opened project file 

to a CSV file.
-

- Exit Exits the SLP-MGW. -
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●● Edit menu configuration

Menu Icon Submenu Description Shortcut

Edit Undo Erases the last change made in the displayed pa-
rameter table and reverts it to its original state.

[Ctrl]＋[Z]

Redo Reverses the changes of the undo action in the dis-
played parameter table.

[Ctrl]＋[Y]

Cut Transfers the content of a selected cell in the con-
figuration parameter table to the clipboard and 
then erases the content in the table.

[Ctrl]＋[X]

Copy Transfers the content of a selected cell in the con-
figuration parameter table to the clipboard.

[Ctrl]＋[C]

Paste Pastes the content in the clipboard to a selected cell 
in the configuration parameter table.

[Ctrl]＋[V]

- Clear Deletes the content of the selected cell in the con-
figuration parameter table.

-

- Select all Selects all cells in a configuration parameter table. [Ctrl] + [A]
Increment vert Adds the values of the cells selected in the configu-

ration parameter table and pastes them in the verti-
cal direction.

-

Increment horz (H) Adds the values of the cells selected in the con-
figuration parameter table and pastes them in the 
horizontal direction.

-

Insert line Inserts a blank line at the selected position. 
The lines that come after the selected position are 
shifted down.

[Ctrl] + [Ins]

Delete line Deletes a selected line. 
The lines that come after the deleted line are 
shifted up to fill the space of the deleted line.

[Ctrl] + [Del]

Move up Moves the selected item up by one line. [Ctrl] + [Up]

Move down Moves the selected item down by one line. [Ctrl] + [Down]

Search Displays a palette window for conducting a charac-
ter string search.

[Ctrl] + [F]

- Replace Displays a palette window for replacing a character 
string with a selected string search.

[Ctrl] + [H]

●● Config menu configuration

Menu Icon Submenu Description Shortcut

Config Add cyclic data transfer Adds a new configuration sheet in an opened project. -

Add trigger data transfer Adds a new configuration sheet in an opened project. -

Add bit alt Adds a new configuration sheet in an opened project. -

- Delete config sheet Deletes a configuration sheet selected in the project 
view.

-

- Rename... Changes the group name of a configuration sheet 
selected in the project view.

-
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●● Online menu configuration

Menu Icon Submenu Description Shortcut

Online Write gateway config PC→NX-MGW... Writes the configuration settings to 
the NX-MGW.

-

Read gateway config NX-MGW→PC... Reads the configuration settings 
from the NX-MGW.

-

Exec monitor... Displays a monitor screen for the ex-
ecution status.

-

NX-MGW Information... Reads information about the NX-
MGW unit (version and history).

-

Connected Device Manager Stops automatic notifications when 
you do not want notifications issued.

-

- Gateway program reset Stops communication during startup 
and restarts from initialization mode.

-

●● Tool menu configuration

Menu Icon Submenu Description Shortcut

Tools Edit My List.. This is used to customize, edit, and 
save MyList.

-

- Update system on NX-MGW... Specifies an IP address for updating 
the NX-MGW system.

-

●● Help menu configuration

Menu Icon Submenu Description Shortcut

Help - Help Shows the User's Manual (PDF file). -

- Version... Displays the version information of 
the SLP-MGW.

-
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■■ Project view

This displays the items that can be set for the various functions of the NX-MGW in a 
tree view format.

The functions are accessed from this project view.

●● Screen layout 

 Project

This appears as the first item in the project.
It shows the project file name.
If the project has not been saved to a file, “New Project” is displayed.

 System

This is for NX-MGW system settings.

•	LAN1: Settings of devices connected to the LAN1 port.

•	LAN2: Settings of devices connected to the LAN2 port.

•	Option: Option settings for the NX-MGW.

 CyclicTransmit

For display of CyclicTransmit settings.
Icons and configuration sheet names are displayed in the project view.
The icon for the configuration sheet varies depending on the transfer direction set-
ting in the sheet.
•	  Slave ← Host Transmission Direction

•	  Slave → Host Transmission Direction

 TriggerTransmit

For display of TriggerTransmit settings. Icon meanings are the same as for 
CyclicTransmit.
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 Bit set

For display of Bit set settings. Icons for writing only always appear as  (Slave ← 
Host).

 Device Management

For display of Device Management settings. It includes the items below.

•	  Backup Restore: 	‌� For configuration of backup or restoration of the 
configuration files of connected devices.

•	  IP address assignment: 	‌�For assignment of IP address settings for connected 
devices.

•	  Status Notification: 	‌� For setup of  notifications sent to the host about the 
status of the NX-MGW.

●● Creating a new configuration sheet

Follow the procedure below to create a new configuration sheet from the right-click 
pop-up menu (displayed by right-clicking the function name) in the project view.

(1) Select the desired new function or configuration sheet in the project view.

(2) From the right-click pop-up menu, select [Add config sheet ].

A new configuration sheet can also be created from the main menu.

(1) Select [Config] from the main menu.

(2) Select the function item that you want to create.

●● Editing a configuration sheet

To edit an existing configuration sheet (cut, copy, paste, or delete the sheet; change 
the order, change the name), select the desired configuration sheet in the project 
view, and then select the edit operation from the right-click pop-up menu. The edit 
operation can also be selected from the main menu.

 Note

•	Multiple configuration sheets cannot be selected at the same time. Select and 
edit one configuration sheet at a time.
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■■ Configuration sheet

A configuration sheet is a window in tabular format for setting the various func-
tions. The configuration sheet that was selected in the project view is displayed.

●● Screen layout

Process settings list

Attribute settings list

●● Attribute settings list

The basic operations (such as host device number and notification processes) of the 
sheet are displayed in list format.

The content that can be set varies depending on the function.

For details,  Chapter 5. Settings.

●● Process settings list

The settings for processes executed by sheets are displayed in list format.

The content that can be set varies depending on the function.

For details,  Chapter 5. Settings.

●● Copy and paste

Cells selected in the configuration sheet can be copied and pasted. Entire lines and 
columns can be pasted, which is useful for entering entire blocks of information. 
Copied data can also be pasted to spreadsheet software, which in turn can be used 
to create documents and other applications.

When creating large volumes of data, shortcut keys can be used for more efficient 
editing ([Ctrl] + [C] for copy and [Ctrl] + [V] for paste).

Blocks of cells can be selected using the methods below.

•	Select all cells: Select the fixed row at the top left corner of the settings list.

•	Row selection: Select the leftmost fixed row of the target row.

•	Column selection: Select in the topmost fixed row of the target column.

●● Batch editing

To edit existing attribute settings or process settings lists (clear, insert row, delete 
row, move up, move down), select a cell in the settings, and select Edit from the 
right-click menu. Edit can also be selected from the main menu.



4-15

Chapter 4.	 SLP-MGW SMART LOADER PACKAGE 

●● Incremental copying

The procedure below can be used to copy and increment the value in a cell.

(1) Select the copy source cell.

(2) Select the consecutive cells where the copy will be pasted.  
In the example below, two copies will be made in the vertical direction.

(3) Right-click, and from the pop-up menu, select [Increment Vert (V)].

>> The value is incremented and copied to the specified cells.
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●● Search

The procedure below can be used to search for character strings in the process set-
tings list.

(1) From the main menu, select [Edit] → [Search].

>> A search palette window appears under the process settings list.

(2) Enter the character string that you want to find.

(3) To search in the downward direction, click the [Next] button.

(4) To search in the upward direction, click the [Prev] button.

(5) To finish searching and close the palette window, click the [×] button.

●● Replace

The procedure below can be used to replace character strings in the process settings 
list.

(1) From the main menu, select [Edit] → [Replace].

>> A search palette and replace palette appear under the process settings list.

(2) Enter the character string that you want to find.

(3) Enter the replacement character string.

(4) Clicking the [>>Exec] button moves to the first matching cell.

(5) Clicking the [>>Exec] button again replaces the character string and moves to 
the next matching cell.

(6) Clicking the [>All] button replaces all matching character strings in the process 
settings list.

(7) To finish replacing and close the palettes, click the [×] button.
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■■ Device Selection palette/Parameter Selection palette

This lists the connected models that were set up in the system and their parameters.

●● Screen layout (slave device)

The screen changes as shown in the figure below when the [Custom/All] button is 
pressed. A bookmark-like parameter list is displayed on the MyList screen, where 
frequently used items are collected. The ALL screen shows all the parameters.

Model selection 

Parameter list

Filter settings

MyList/All switchover

Parameter type selectionMyList selection

●● Model selection

The connected devices are displayed in a tree view format. Multiple devices can be 
selected.

●● MyList selection

The available MyLists are selected from a drop-down list.

●● My List/All switchover

When [MyList] is selected, parameters registered to MyList only are displayed. 
When [ALL] is selected, all parameters of the selected device are displayed.

●● Parameter type selection

This appears only when [ALL] is selected by the [MyList/ALL] switchover button. 
The displayed items vary depending on the model selected in the model selection.

●● Filter settings

The displayed parameters can be filtered to display only those parameters contain-
ing a specified character string in the name.
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●● Parameter list

This displays the parameters of the slave device selected in the model selection in a 
list format.

To the left of each parameter, one of the icons below is displayed.

•	 	  Read-write parameter.

•	 	  Read-only parameter.

•	 	  Write-only parameter.

 Handling Precautions

•	For some temperature controllers and other devices, it is possible to select 
whether to write to RAM or ROM (EEPROM). When data is written to ROM, 
the written value is retained even after the power is turned off and on 
again, but the number of writes is limited. For details, see the instruction 
manual for the respective device.

●● Screen layout (host device)

Model selection

Device list

Direction buttons

Device type selection

Starting device address

●●Device type selection

The type of devices shown in the device list is selected here.

●●Starting device address

This specifies the starting device address for the device shown in the device list.

●●Device list

This displays the host devices selected in the model selection in a list format in 
groups of 100 devices.

●●Direction buttons

The starting device address is moved by -100 or +100 using the right and left but-
tons. The position is changed by +1 and -1 by the up and down buttons.
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●● Drag & drop

The procedure below can be used to easily drag and drop items from the parameter 
list to a function configuration sheet.

(1) Target model selection

(2) Address selection

(4) Drop

(3) Drag

(1) Select the input target model in the model selection area.

(2) Select the parameter to be input from the parameter list.

(3) Click on the selected item(s), hold down the mouse button , and drag the 
item(s) to the desired location in the process settings list.

(4) Drop the items onto the process settings list by releasing the mouse button.

●● Copy and paste

The copy and paste functions can be used to enter parameter list information to the 
function configuration sheet.

(1) Select the input target model in the model selection area.

(2) Select the parameter to be input from the parameter list.

(3) From the right-click pop-up menu, select [Copy]. To execute from the main 
menu, select [Edit] → [Copy].

(4) To paste, either select [Paste] from the right-click pop-up menu over the item 
where the address will be input in the process settings list, or from the main 
menu, select [Edit] → [Paste].
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●● Pasting multiple selections

Multiple items can be copied and pasted for input of consecutive items onto the 
function configuration sheet.

●●Example: Selecting multiple parameters

When parameter addresses 14360, 14361, and 14362 of NX-D15 device No. 1-2 on 
interface LAN1 are selected in the device selection area

Device no. Device parameter

1-2 14360: Loop 2 Run/Ready
1-2 14361: Loop 2 Auto/Manual
1-2 14362: Loop 2 AT cancel/AT execute

●●Example: Selecting multiple devices

When parameter address 14360 of NX-D15 device Nos. 1-2, 1-3, and 1-4 on inter-
face LAN1 are selected in the device selection area

Device no. Device parameter

1-2 14360: Loop 2 Run/Ready
1-3 14360: Loop 2 Run/Ready
1-4 14360: Loop 2 Run/Ready

●●Example: Selecting multiple parameters for multiple devices

When parameter addresses 14360, 14361, and 14362 of NX-D15 device Nos. 1-2, 
1-3, and 1-4 on interface LAN1 are selected in the device selection area

Device no. Device parameter

1-2 14360: Loop 2 Run/Ready
1-2 14361: Loop 2 Auto/Manual
1-2 14362: Loop 2 AT cancel/AT execute
1-3 14360: Loop 2 Run/Ready
1-3 14361: Loop 2 Auto/Manual
1-3 14362: Loop 2 AT cancel/AT execute
1-4 14360: Loop 2 Run/Ready
1-4 14361: Loop 2 Auto/Manual
1-4 14362: Loop 2 AT cancel/AT execute
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■■ Information list

If an error is found in the settings of the function configuration sheet, an error mes-
sage appears in the information list.

The information below is shown in the error message.

•	Category:	‌� CyclicTransmit, TriggerTransmit, Bit set, Device Management, etc.

•	Sheet:	 Sheet number where error occurred

•	Parameter:	 Name of parameter where error occurred

•	Value:	 Value entered when error occurred in numerical value

•	Note:	 Setting error description

Some examples of setting error descriptions are shown in the table below.

Message Type Description

Duplicate value. Information This is displayed when a duplicate address is specified for a trigger device. 
Because the value itself is not an error, the setting can be written to the 
NX-MGW.

Settings are incomplete Warning This is displayed when a required setting has not been set.
Invalid value. Error This is displayed when there is an error in the input setting.
Out of range. Error This is displayed when a value outside the allowable range was entered.
Read-only. Error This is displayed if the user tries to overwrite a read-only value (such as a 

constant).
Not yet configured. Error This is displayed when an item that has not been configured is selected (such 

as a connected device).
The upper limit on the 
number of operations was 
exceeded.

Error This is displayed when the limit for the maximum number of processes per 
function was exceeded. 
The maximum number of processes is 4000 for DataTransmit and 400 for Bit 
set.

Connected device upper 
limit exceeded

Error This is displayed when the maximum number of connected devices that can 
be set (32) was exceeded.

SYNC upper limit exceeded Error This is displayed when the limit on the number of SYNCs that can be specified 
in data transfer (10) was exceeded.

Network address differs 
from NIC

Error This is displayed when the IP address setting is different from the setting for 
the network address of the network card.

Too many characters Error This is displayed when the character string that was set exceeds the maximum 
number of allowable characters (20) for the sheet name.

This IP address is already 
used for the loader.

Error This is displayed when the address fixed for communication with the SLP-
MGW is specified.

It is not possible to set the 
same address that is set as 
the loader network address.

Error This is displayed when the fixed address set for communication with the SLP-
MGW is the same as the network IP address.

If an error occurs in the settings, the settings cannot be transmitted to the NX-MGW.

To move to the actual location of the error, double-click the row where the error is 
displayed. You can also select the row and press the [Enter] key.

>> ‌�The target configuration sheet appears, and the cursor moves to the cell where 
the error is located.
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4 - 6 	 Connection with NX-MGW

■■ Computer communication settings

●● Procedure

This shows how to change the IP address of the computer to allow connection to 
the NX-MGW. The LAN2 connector of NX-MGW uses multiple IP addresses for 
connecting to SLP-MGW and is set to the fixed IP address 192.168.255.253. This 
describes the settings when connecting using an IP address for connecting the SLP-
MGW to a LAN2 connector.

(1) ‌�Select [Control Panel] → [Network and Internet] → [View network status and tasks].

>> The Network and Sharing Center window opens.

(2) Click the character string on the right side of the network connected to the 
NX-MGW. Normally, this character string appears as “Ethernet” or “Local area 
connection.”
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>> The Ethernet Status window opens.

(3) Click the [Properties] button.

>> The Ethernet Properties window opens.

(4) Select “Internet Protocol Version 4 (TCP/IPv4)”, and click the [Properties] 
button.
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>> The Internet Protocol Version 4 (TCP/IP4) Properties window opens.

(5) Select “Use the following IP address”, and set the values below for the IP address 
and subnet mask. If connecting directly to the NX-MGW, the default gateway 
does not need to be set.  
 
IP address: 	 192.168.255.252 
Subnet mask: 	255.255.255.0

(6) If communication is already taking place with another device using a fixed IP, 
click the [Advanced...] button.
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>> The Advanced TCP/IP Settings window opens.

(7) Click the [Add...] button.

>> The TCP/IP Address window opens.

(8) Set the IP address and subnet mask to the values below, and click the [Add] button.  
 
IP address: 192.168.255.252 
Subnet mask: 255.255.255.0

(9) Click the [OK] button to close the Internet Protocol Version 4 (TCP/IPv4) 
Properties window.



4-26

Chapter 4.	 SLP-MGW SMART LOADER PACKAGE 

■■ Communication status

IP address setting

Communication status

Progress

Cancel/closeOK

●● IP address setting

Specify the IP address of the connected NX-MGW.

●● Communication status

This displays the current status of communication.

●● Progress

Communication progress is displayed as a percentage and bar graph.

●● OK

This is used when executing the two processes below.

•	Write gateway config PC→NX-MGW

•	Read gateway config NX-MGW→PC

Clicking [OK] starts the process.

●● Cancel/Close

Clicking [Cancel] aborts the communication process that is being executed.

If the communication process was aborted (canceled or ended due to error), click 
the [Close] button.

After checking the status, click the [Close] button to close the window.

■■ Writing the gateway configuration

●● Procedure

(1) From the main menu, select [Online] → [Write gateway config PC → NX-MGW].

>> The Communication Status window opens.

(2) Clicking [OK] starts writing of the gateway configuration.

>> If communication ends normally, the Communication Status window closes.
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●● Explanation

•	If a project file is open, its settings are written to the NX-MGW. If no project file is 
open, the Select Project File window opens.

•	If an error was found in the project settings, an error message appears. Since there 
is an error, it is not possible to download.

•	A message is displayed to confirm switching of the NX-MGW to STOP mode. If 
[OK] is clicked in response to this message, the NX-MGW is switched to STOP 
mode, and writing of the configuration is started. If [Cancel] is selected, the set-
tings are not written.

•	After writing of the configuration is completed, the gateway program restarts au-
tomatically, and operation is switched to RUN mode.

■■ Reading the gateway configuration

●● Procedure

(1) From the main menu, select [Online] → [Read gateway config NX-MGW→PC].

>> The Save Project File window opens.

(2) Select a project file where the reading settings will be saved.

(3) Clicking the [OK] button closes the Save window and opens the Communication 
Status window.

(4) Clicking [OK] starts reading of the gateway configuration.

>> If communication ends normally, the Communication Status window closes.

●● Explanation

The mode is not changed during reading of the gateway configuration file.
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■■ Checking the execution status

●● Procedure

(1) From the main menu, select [Online] → [Execution Status].

>> The Execution Status window opens.

(2) Click the Monitor button.

>>  The screen is updated regularly.

(3) To stop updating, click the Monitor button again.

(4) To exit, click the [Close] button.

Data transfer statusConnected 
device status

 Monitor

This starts and stops monitoring of the connected device status and data transfer 
process status.

 Save

The information that was read is saved to a file in CSV format.

 Copy

The content of the selected cell is transferred to the clipboard.

 Clear

This clears the monitor information (various counters, execution time).

Connected device status

This shows the connection status of connected devices and the communication ex-
ecution count and error count.

Data transfer status

This shows the execution count and error count of various data transfer processes 
and the past 10 processing times (execution cycle for CyclicTransfer).
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■■ Reading NX-MGW information

●● Procedure

(1) From the main menu, select [Online] → [NX-MGW Information].

>> The NX-MGW Information window opens.

(2) Click the Refresh button.

>> The screen is updated.

(3) To update to the latest information, click the [Refresh] button again. 

 Refresh

This reads and displays the NX-MGW information and communication error history 
and operation history.

 Save

The information that was read is saved to a file in CSV format.

 Copy

The content of the selected cell is transferred to the clipboard.
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●● NX-MGW Information

●●Model number

This shows the NX-MGW model number.

●●Version

This shows the NX-MGW version.

●●Status

This shows the NX-MGW status. The statuses below are used.
•	Initializing
•	Judging connected devices
•	RUN
•	STOP
•	Illegal Stop

●●Project name

This displays the name of the configuration file written to the NX-MGW.

●● Comm Error History

●●Time

This displays the amount of time between startup and event occurrence.

●●Event

This shows a description of the event that occurred.
●●Code

This shows the error code when an error response was received from a connected device.
●●Device no.

This shows the number of the device wherethe communication error occurred or 
was reset.

●●Device address

This shows the address of the device where the communication error occurred or 
was reset.
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●● Operation history

●● Time

This displays the time between startup and event occurrence.

●● Operation

This gives a description of the operation that was performed.

●● Result

This shows the result when a Backup Restore or IP address assignment was ex-
ecuted for a connected device.

●● Code

This shows a description of the error when execution of a Backup Restore or IP ad-
dress assignment for a connected device fails.

●● Device no.

This shows the number of a connected device for which Backup Restore was 
executed.
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■■ Running the Connected Device Manager

●● Procedure

(1) From the main menu, select [Online] → [Connected Device Manager].

>> The Connected Device Manager window opens.

(2) Click the button of the function that you want to execute.

●● IP address assignment

This assigns an IP address based on the configuration settings written to the 
NX-MGW.

During execution, the gateway program is set to the STOP status.

Once execution is complete, the gateway program is set to the RUN status again.

●● Backup Device Config (NX-MGW←Device)

This backs up the configuration of the connected device based on the configuration 
settings written to the NX-MGW.
During execution, the gateway program is set to the STOP status.
Once execution is complete, the gateway program is set to the RUN status again. 

●●No.

This shows the device number of the connected device.

●●Name

This shows the name of the connected device.
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●●Status

This shows the process status.

●●Result

This shows the process result.

●●Cancel/Close

Clicking [Cancel] aborts the communication process that is being executed.

If the communication process was aborted (canceled or ended due to error), click 
the [Close] button.

After checking the status, click the [Close] button to close the window.

●● Restore device config (NX-MGW → Device)

This restores the settings of the connected device based on the configuration set-
tings written to the NX-MGW.

During execution, the gateway program is set to the STOP status.

Once execution is completed, the gateway program is set to the RUN status again. 

●● Read Setup Data (PC ← NX-MGW)

This reads the gateway configuration in the NX-MGW and backed-up connected de-
vice configuration file, and saves them together as a single file.

●● Write Setup Data (PC → NX-MGW)

This retrieves the gateway configuration and backed-up connected device configu-
ration file from the setup file created by Read Setup Data and writes them to the 
NX-MGW.

 Note

•	A message is displayed to confirm switching of the NX-MGW to STOP mode. If 
[OK] is clicked in response to this message, the NX-MGW is switched to STOP 
mode, and writing is started. If [Cancel] is selected, writing is not performed.

•	After writing is completed, the gateway program restarts automatically, and op-
eration is switched to RUN mode.
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4 - 7 	 MyList Editor

■■ Screen layout

Parameter selection

MyList

Menu
Toolbar

MyList selection
view

●● Menu

The available items are shown in the menu.

●● Toolbar

This shows buttons associated with the menu items.

●● MyList selection view

This displays the MyList for each device in a tree view format.

●● MyList

The MyList selected from the MyList selection view is shown in a list format.

●● Parameter selection

This displays the parameter list of the device selected from the MyList selection 
view.

Parameters from this list can be dragged and dropped to MyList.

■■ Menu configuration

●● File menu contents

Menu Icon Submenu Description Shortcut

File Import... Reads the parameter list file (*.mgwul) and adds My List to 
the selected device.

-

Export... Saves the selected device or My List to a parameter list file 
(*.mgwul).

-

- Exit Exits the MyList editor. -
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●● Edit menu contents

Menu Icon Submenu Description Shortcut

Edit Undo Erases the last change made in the 
displayed MyList and reverts it to its 
original state.

[Ctrl] + [Z]

Redo Reverses the changes of the undo ac-
tion in the displayed MyList.

[Ctrl] + [Y]

Cut Transfers the content of a selected cell 
in MyList to the clipboard and then 
erases the content from the table.

[Ctrl] + [X]

Copy Transfers the content of a selected 
cell in MyList to the clipboard.

[Ctrl] + [C]

Paste Pastes the content in the clipboard to 
a selected cell in MyList.

[Ctrl] + [V]

- Select all Selects all cells in MyList. [Ctrl] + [A]
Add selected items to list Adds the items selected in parameter 

selection to MyList.
-

Delete selected items from list Deletes the items selected in MyList. -

Copy addresses to clipboard Transfers the address selected in 
MyList to the clipboard.

[Shift] + [Ctrl] + [C]

Add addresses from clipboard Adds the addresses in the clipboard 
to MyList.

[Shift] + [Ctrl] + [V]

Move up Moves the selected item up by one line. [Ctrl] + [Up]

Move down Moves the selected item down by one line. [Ctrl] + [Down]

●● List (L) menu contents

Menu Icon Submenu Description Shortcut

List Add new list Adds a blank MyList to a device se-
lected in the MyList selection.

-

Add default list Adds a MyList that is set with default 
items to the device that is selected by 
the MyList selection.

-

Delete list Deletes a configuration sheet se-
lected by the MyList selection.

[Ctrl] + [Del]

- Change name... Changes the name of the MyList se-
lected in the MyList selection view.

-
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■■ Adding and Deleting My Lists

●● Creating a new My List

This creates a new My List from the right-click pop-up menu in the MyList selec-
tion view.

(1) Select the device (or MyList) where you want to create a new MyList in the 
MyList selection view.

(2) From the right-click pop-up menu (or [List] in the main menu), select  [Add 
new list].

To add a MyList that is set with the default items, from the right-click pop-up menu 
(or [List] in the main menu), , select [Add default list].

●● Editing My List

To edit an existing MyList (cut, copy, paste, delete list, change order, change name), 
select the MyList in the MyList selection view, and select Edit from the right-click 
pop-up menu. Edit can also be selected from the main menu.

 Note

•	Multiple MyLists cannot be selected at the same time. Select and edit one at a time.

■■ My List Editor

●● Change name

Double-clicking the selected cell (or pressing the [F2] key) enables editing of the 
name. The name can also be changed by directly entering a character string.

A selected cell can also be copied and pasted to change the name.

●● Add selected items to a list

After the items to be added are selected in the parameter selection, from the right-
click pop-up menu (or [Edit] in the main menu), select [Add selected items to list]. 
The selected items are added to the end of MyList.

Items can also be added by selecting them from the parameter selection and drag-
ging and dropping them into MyList.

●● Copy addresses to clipboard

Select the address lines in MyList that you want to transfer to the clipboard, and 
from the right-click pop-up menu (or [Edit] in the main menu), select [Copy ad-
dresses to clipboard]. This enables the transferring of the device addresses in the 
selected lines to the clipboard as text separated by line feed characters.
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●● Add addresses from clipboard

In MyList, open the right-click pop-up menu (or [Edit] in the main menu), and 
select [Add addresses from clipboard]. This enables the adding of text containing 
device addresses separated by line feed characters to MyList from the clipboard.

Addresses that are already contained in MyList and addresses not found in the pa-
rameter list cannot be added to MyList.

●● Delete selected items from list

After the items to be deleted are selected in MyList, from the right-click pop-up 
menu (or [Edit] in the main menu), select [Delete selected items from list]. The 
selected items are deleted from MyList.

■■ Exporting and importing lists

This is a function for saving a MyList to a file when using a MyList on another 
computer. Once a MyList is saved to a file, it can be read by the My List Editor of an 
SLP-MGW on another computer and added as a MyList.

●● Export

Select the MyList or device to be exported in the MyList selection view, and from 
the right-click pop-up menu (or [File] in the main menu), select [Export...]. The 
Save As window opens. Enter the file name and select [Save].

●● Import

Select the MyList or device to be read in the MyList selection view, and from the 
right-click pop-up menu (or [File] in the main menu), select [Import...]. The Open 
File window opens. Select the file to be opened, and select [Open].

 Note

If MyList files from different models are imported, an error message appears indi-
cating that the definitions are invalid, and the import process is aborted.



Memo
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■■ Project file

The files used by the SLP-MGW are shown below.

Icon Extension Description

*.mgw Project file created by SLP-MGW

●● Creating new project files

(1) Select [File] → [Create new project].

>> A new project is created, and the Project View is displayed.

●● Opening project files

(1) Select [File] → [Open project file].

>> The Open window appears.

(2) Select the file to be opened. (To specify the file name directly, enter the file name 
in the field [File name].)

(3) Click the [Open] button.

>> The specified project file opens.

 Note

•	The default project folder when running for the first time is My Documents. 
After that, the default project folder is set to the folder that was selected.

●● Re-opening project files

(1) Select [File] → [Re-open project].

>> A menu containing a list of recently-opened project files appears.

(2) Select the file to be opened.

>> The selected project file is opened.
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●● Saving project files

(1) Select [File] → [Save project].

>> The project is saved to a file.

 Note

•	If the project has not yet been saved, the Save As window opens.

●● Saving project files using a specified name

(1) Select [File] → [Save project as].

>> The Save As window opens. 

(2) Open the folder where the file will be saved, and enter the file name. (To over-
write an existing file, simply select the file.)

(3)  Click the [Save] button.

>> The project is saved to a file with the specified name.

 Note

•	The default project folder when the program is run for the first time is My 
Documents. After that, the default project folder is set to the folder that was last 
selected.

●● Close project

(1) Select [File] → [Close project].

>> This closes the open project.

>> If an attempt is made to close a project that was modified but not saved, a warn-
ing message appears.
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5 - 2 	 Configuration Sheet Details

Details about configuration sheets are described here. Parameters are listed vertically in the attribute settings list. 
Parameters are listed horizontally in the process settings list.

■■ System - LAN1/LAN2

This determines the settings for the devices that communicate through the LAN1 
or LAN2 connectors on the NX-MGW.

The attribute settings list includes the items below.

Parameter name Description

IP address IP address of the LAN1 or LAN2 connector on the 
NX-MGW

Subnet mask Subnet mask of the network connected to the LAN1 or 
LAN2 connector on the NX-MGW

Default gateway Default gateway of the network connected to the 
LAN1 or LAN2 connector on the NX-MGW

Each item is described below.

●● IP address

The IP address of the NX-MGW is set here. The LAN1 connector and LAN2 con-
nector are set separately.
•	Range: 	 1.0.0.1 to 223.255.255.254 (excluding 127.*.*.*)
•	Default values: 	‌� 192.168.0.127 (LAN1) 

192.168.4.127 (LAN2)

 Handling Precautions

•	LAN1 and LAN2 cannot be set to the same network address.

•	The LAN2 connector uses multiple IP addresses for connecting to SLP-
MGW and is set to the fixed IP address 192.168.255.253. It cannot be set to 
192.168.255.* of the same segment of the IP address used to connect to the 
SLP-MGW.

●● Subnet mask

The subnet mask for the IP address of the NX-MGW is set here. The LAN1 connec-
tor and LAN2 connector are set separately.
•	Range: 	 128.0.0.0 to 255.255.255.252
•	Default value: 	255.255.255.0

 Handling Precautions

•	When a supernet setting (such as 255.255.0.0 for class C) is used for the sub-
net mask, if the IP address assignment is run for the Network Instrumentation 
Module, the setting using the SLP-NX can no longer be used.
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●● Default gateway

The default gateway for the IP address of the NX-MGW is set here. The LAN1 con-
nector and LAN2 connector are set separately. If this is blank, the setting is “No 
default gateway.”
•	Range: 	 Blank or 1.0.0.1 to 223.255.255.254 (excluding 127.*.*.*)
•	Default value: 	Blank

The process settings list includes the items below.

Parameter name Description

Device Connected device
IP address IP address of connected device
Port Standby port number for connected device
Transport layer TCP or UDP is selected
Retry-count Number of retries when no response is received
Time-out time Elapsed time until a transmission is determined to have no 

response
Enabled/Disabled Selection of whether a registered device is used or not
Host No. Host device number that reads out the judgment device 

when Enabled/Disabled is set to "Start-up judging"
Judgment Device Judgment device that reads out from the host device when 

Enabled/Disabled is set to "Start-up judging"
Read Device Max Maximum data count that can be requested at once in 

communication frames that perform reading
Write Device Max Maximum data count that can be requested at once in 

communication frames that perform writing
Send Delay Time Wait time each time before sending is started
Option 1 Additional setting for communication
Option 2 Additional setting for communication

Each item is described below.

●● Device

The connected device is selected from the pull-down menu. If no target device is 
available for a setting item, select Modbus-TCP, CPL-TCP, or other general-purpose 
device for each communication protocol.
•	Range: ‌�Mitsubishi-Q 

Yokogawa FA-M3 
NX-15, NX-25, NX-35, NX-DX, NX-DY 
Modbus-TCP 
CPL-TCP or other (added sequentially)

•	Default value: ---
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●● IP address

This sets the IP address of the connected device that was set for “Device.”
•	Range: 	 0.0.0.1 to 255.255.255.254
•	Default value: 	Blank

 Handling Precautions

•	Set so that there are no duplicate IP addresses for any of the devices or the 
NX-MGW.

•	If the default gateway is not set, set an IP address within the same subnet of 
the connected LAN connector.

●● Port

This sets the port number of the connected device that was set for “Device.” The 
NX-MGW is the client, and the device is the server. Data is sent from the NX-MGW 
to the port having this setting.
•	Range: 	 0 to 65535
•	Default value: 	Depends on device

●● Transport layer

This is used to select the type of communication transport layer to the connected 
device that was set for “Device.” 
In some cases, this cannot be set because the value is fixed for certain devices.
•	Range: 	 TCP, UDP
•	Default value: 	Depends on the device

●● Retry-count

This sets the number of retries of the connected device that was set for “Device.” A 
retry is a resend process to a single connected device. A retry is performed when no 
response was received from a device by the NX-MGW.
•	Range: 	 0 to 10 attempts
•	Default value: 	3

●● Time-out time

This sets the time until a time-out occurs for the connected device that was set for 
“Device.” The time-out time is the elapsed time until a transmission is determined 
to have no response.
•	Range (Units: sec): 	 100 to 60000
•	Default value: 	 1000

●● Enabled/Disabled

This selects whether the settings are used for the connected device that was set in 
“Device.” If set to “Disabled,” even if communication settings for this device are set, 
all gateway functions and device management functions are disabled. If “Start-up 
judging” is selected, the setting that was written to “Judgment Device” of the host 
device is read and determined at startup.
•	Range: 	 Enabled, Disabled, Start-up judging
•	Default value: 	Enabled
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●● Host No.

If “Start-up judging” is selected for the “Enabled/Disabled” setting, this selects the 
host device that reads the “Judgment Device” at startup.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Judgment Device

If “Start-up judging” is selected in the “Enabled/Disabled” setting, this sets the 
“Judgment Device” that reads from the host device at startup.
•	Range: 	 Depends on the device
•	Default value: 	Blank

●● Read Device Max

This specifies the maximum data count that can be requested at once in communi-
cation frames that perform reading. This value is determined by the communica-
tion protocol and device specifications. In some cases, this cannot be set because 
the value is fixed for certain devices.
•	Range: 	 1 to 512
•	Default value: 	Depends on the device

●● Write Device Max

This specifies the maximum data count that can be requested at once in communi-
cation frames that perform writing. This value is determined by the communication 
protocol and device specifications. In some cases, this cannot be set because the 
value is fixed for certain devices.
•	Range: 	 1 to 512
•	Default value: 	Depends on the device

●● Send Delay Time

This sets the wait time each time before sending is started. Adjust this setting if 
communication is not completed or control performance is reduced due to heavy 
communication traffic.
•	Range (Units: msec): 	1 to 1000
•	Default value: 	 Depends on the device

●● Option 1, Option 2

These are additional settings for communication. This is set separately for each device.
•	Range (unit: number of times): 	Depends on the device.
•	Default value: 	 Depends on the device
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■■ System - Options

This is for the overall operation settings for the NX-MGW.

It includes the items below.

Parameter name Description

Startup delay-time (sec) Communication start wait time after startup is completed
Cyclic scan-cycle CyclicTransmit is execution cycle
Trigger scan-cycle Cycle for checking the trigger device values for 

TriggerTransmit
Status notification interval Execution cycle for Cyclic ON Notify and Notify Disconnect
Sync wait time Wait time until the next line is executed after execution of a 

sync line in the sheet
Init trigger device Setting that determines whether a trigger device is turned 

off after a trigger is detected
Init notify device Setting that determines whether a notification device is 

turned off before the processing of each sheet begins

Each item is described below.

●● Startup delay-time (sec)

This sets the communication start wait time after startup is completed. This is set if 
the power for all of the equipment is switched on simultaneously but the connected 
devices are not ready for communication by the time the startup of the  
NX-MGW is completed.
•	Range (units: seconds): 	0 to 60
•	Default value: 	 0

 Handling Precautions

•	It takes the NX-MGW about 20 seconds from power-on until it is ready for 
communication. “Delay-time (sec)” sets an additional wait time after the NX-
MGW is ready for communication.

●● Cyclic scan-cycle

The cycle for executing CyclicTransmit is selected from the pull-down menu. The 
NX-MGW starts the processing of unexecuted CyclicTransmit sheets according to 
the cycle that is set here.
•	Range (units: msec):	100 to 1000 ( in 100 msec units)
•	Default value: 	 200 msec

●● Trigger scan-cycle

The cycle for monitoring startup trigger devices for TriggerTransmit is selected 
from the pull-down menu. The NX-MGW starts the trigger determination process-
ing of unexecuted TriggerTransmit sheets according to the cycle that is set here.
•	Range (units: msec): 	100 msec to 1 sec (selected in 100 msec units)
•	Default value: 	 500 msec
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●● Status notification interval
The cycle for executing Cyclic ON Notify and Notify Disconnect is selected from 
the pull-down menu. Cyclic ON Notify is a function that sends a notification that 
the NX-MGW is running, and Notify Disconnect sends a notification that a con-
nected device has not responded. Both of these functions send notifications at the 
interval determined by this setting.
•	Range (units: sec): 	1 sec to 10 sec (in 1 sec units)
•	Default value: 	 5 sec

●● Sync wait time
This is the wait time until the next line is executed after execution of a sync line in 
the sheet.
•	Range (units: msec): 	0 msec to 1 sec (in 100 msec units)
•	Default value: 	 500 msec

●● Init trigger device
The user selects from a pull-down menu whether or not the NX-MGW turns off the 
trigger device after a trigger is detected by TriggerTransmit, Bit set, Backup All, 
Restore All, or IP address assignment. The trigger device is turned off if “Enabled” 
is selected.
•	Range: 	 Disabled, Enabled
•	Default value: 	Enabled

●● Init notify device
The user selects from a pull-down menu whether or not the NG-MGW turns off the 
devices for “Notify Complete,” “Notify Error,” and “Notify Result” before starting to 
process the respective sheet. The trigger device is turned off if “Enabled” is selected.
•	Range: 	 Disabled, Enabled
•	Default value: 	Disabled
Init trigger device and Init notify device are executed at the timing shown in the fig-
ure below. (In a scan cycle, the trigger device is not checked or initialized.)

Trigger scan-cycle
Cyclic scan-cycle

Noti�cation device

Data con�guration 
sheet 1

ON

OFF

Trigger device

Init trigger device and Init notify device

ON

OFF

Processing

Stopped

ON con�rmationON con�rmationON con�rmationON con�rmation

 Handling Precautions

•	Processing of each sheet continues even if a communication error occurs for 
Init trigger device or Init notify device.
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■■ CyclicTransmit
This determines the settings for cyclic data transfer (CyclicTransmit).

The attribute settings list includes the items below.

Parameter name Description

Name Sheet name
Transmit Direction Data transfer direction within a sheet
Host No. Host device connected by data transfer within sheet
Notify Complete Device Host device that turns ON when data transfer within 

the sheet is complete
Notify Error Device Host device that turns ON when data transfer within 

the sheet ends due to an error

Each item is described below.

●● Name

This sets the sheet name. A name change that was done in the project view is also 
shown here.
•	Range (units: sec): 	Value that was set in project view
•	Default value: 	 CyclicTransmit 1

●● Transmit Direction

The data transfer direction within the sheet is selected from the pull-down menu.
•	Range (units: sec):	  ‌�Read (Slave → Host), Write (Slave ← Host)
•	Default value:	  Read (Slave → Host)

●● Host No.

The host device connected by data transfer within the sheet is selected from a pull-
down menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Notify Complete Device

This sets the host device that turns ON when data transfer within the sheet is com-
pleted. Notify Complete is not performed if this is left blank.
•	Range: Depends on the host device
•	Default value: Blank

●● Notify Error Device

This determines the host device that turns ON when data transfer within the sheet 
ends due to an error. Notify Error is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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The process settings list includes the items below.

Parameter name Description

Slave No. Slave device that performs transmission at each line
Slave Device Address Address of device that sends slave device 

transmissions
Data Count Transmission data length 

If set to "2", the data for two device addresses are 
transmitted in the same communication message.

Host Device Address of device that sends host device 
transmissions

Each item is described below.

●● Slave No. 

The slave device that sends a transmission at each line is selected from the pull-
down menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Slave Device Address 

This sets the address of the slave device that transmits at each line.
•	Range: 	 Depends on the slave device
•	Default value: 	Blank

●● Data Count

The amount of data that is transmitted at each line is selected from the pull-down 
menu. If “1” is selected, one device address is transmitted. If “2” is selected, two pa-
rameters are transmitted using the same communication frame.

The second device address is the address that was set by “Slave Device Address” + 1, 
and the host device address is the address that was set by “Host Device Address” + 1.
•	Range: 	 1 or 2
•	Default value: 	1

●● Host Device Address

This sets the host device that performs transmission at each line.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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■■ Trigger Transmit

This determines the settings of cyclic data transfer (CyclicTransmit).

The attribute settings list includes the items below.

Parameter name Description

Name Sheet name
Transmit Direction Data transfer direction within sheet
Host No. Host device connected by data transfer within sheet
Trigger Device Executes transmission of a sheet if the trigger device is 

turned on for executing TriggerTransmit
Notify Complete Device Host device that turns ON when data transfer within the 

sheet is complete
Notify Error Device Host device that turns ON when data transfer within the 

sheet ends due to an error

Each item is described below.

●● Name

This sets a sheet name. A name that was changed in the project view is also changed 
here.
•	Range (units: sec): Value that was set in project view
•	Default value: TriggerTransmit 1

●● Transmit Direction

The data transfer direction within the sheet is selected from the pull-down menu.
•	Range (units: sec): ‌�Read (Slave → Host), Write (Slave ← Host)
•	Default value: Read (Slave → Host)

●● Host No.

The host device connected by data transfer within the sheet is selected here.
•	Range: Selected from connected devices that were registered
•	Default value: ---

●● Trigger Device

This sets the host device that serves as the trigger device for executing the 
TriggerTransmit sheet.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Complete Device

This sets the host device that turns ON when data transfer within the sheet is com-
pleted. Notify Complete is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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●● Notify Error Device

This sets the host device that turns ON when data transfer within the sheet ends 
due to an error. Notify Error is not done if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

The process settings list includes the items below.

Parameter name Description

Slave No. Slave device that performs transmission at each line
Slave Device Address Address of device that sends slave device transmissions
Data Count Transmission data length 

If set to "2," the data for two device addresses is trans-
mitted in the same communication message.

Host Device Address Address of device that sends host device transmissions

Each item is described below.

●● Slave No. 

The slave device that sends a transmission at each line is selected from the pull-
down menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Slave Device Address 

This sets the address of the slave device that sends a transmission at each line.
•	Range: 	 Depends on the slave device
•	Default value: 	Blank

●● Data Count

The data count that is transmitted at each line is selected from the pull-down menu. 
If “1” is selected, one device address is transmitted. If “2” is selected, two device ad-
dresses are transmitted using the same communication frame.

The second device address is the address that was set by “Slave Device Address” + 1, 
and the host device address is the address that was set by “Host Device Address” + 1.
•	Range: 	 1 or 2
•	Default value: 	1

●● Host Device Address

This sets the host device that sends a transmission at each line.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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■■ Bit set

This sets Bit set.

The attribute settings list includes the items below.

Parameter name Description

Name Sheet name
Host No. Host device connected by data transfer within sheet

Each item is described below.

●● Name

This sets the sheet name. A name change that was executed in the project view is 
also shown here.
•	Range (units: sec): 	Value that was set in project view
•	Default value: 	 Bit set 1

●● Host No.

The host device connected by Bit set within the sheet is selected from the pull-down 
menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

The process settings list includes the items below.

Parameter name Description

Slave No. Slave device that executes Bit set for each line
Slave Device Address Address of slave device that executes Bit set
Trigger (Write ON) Turns on the slave device for each line when a trigger 

device turns ON for executing Bit set
Trigger (Write OFF) Turns off the slave device for each line when a trigger 

device turns ON for executing Bit set
Notify Complete Host device that turns ON when Bit set within the sheet 

is complete
Notify Error Host device that turns ON when Bit set within the sheet 

ends due to an error

●● Slave No. 

The slave device that sends a transmission at each line is selected from the pull-
down menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Slave Device Address 

This sets the address of the slave device that performs writing at each line.
•	Range: 	 Depends on the slave device
•	Default value: 	Blank
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●● Trigger (Write ON)

This sets the host device that serves as the trigger device for setting a slave device to 
ON.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Trigger (Write OFF)

This sets the host device that serves as the trigger device for setting a slave device to 
OFF.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Complete Device

This sets the host device that turns ON when Bit set within each line is complete. 
Notify Complete is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Error Device

This sets the host device that turns ON when data transfer within a line ends due to 
an error. Notify Error is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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■■ Device Management - Backup Restore

This is for the Backup Configuration and Restore Configuration settings.

The attribute settings list includes the items below.

Parameter name Description

Host No. Host device that performs trigger determination and 
notification

Backup All Trigger Host device that backs up all configurations of the con-
nected slave devices (executed at ON)

Restore All Trigger Host device that restores all configurations of the con-
nected slave devices (executed at ON)

 Note
•	Backup All and Restore All are not executed for devices where “Enabled/

Disabled” is set to “Disabled.”

●● Host No.

The host device connected by Backup Restore within the sheet is selected from the 
pull-down menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Backup All Trigger

This sets the host device that serves as the trigger device for executing Backup All.
•	Range: 	 Depends on the host devices
•	Default value: 	Blank

●● Restore All Trigger

This sets the host device that serves as the trigger device for executing Restore All.
•	Range: 	 Depends on the host devices
•	Default value: 	Blank

The process settings list includes the items below.

Parameter name Description

Device (View only) Shows the slave device that is backed up or restored
Backup Trigger Host device that backs up the individual configuration of a 

connected slave device for all lines (executed at ON)
Restore Trigger Host device that restores the individual configuration of a 

connected slave device for all lines (executed at ON)
Notify Result Host device that sends 0 when the backup or restore process 

for a slave device is successful for all lines. 
A failure code is sent if processing fails.

Notify Complete Host device that turns ON when the backup or restore pro-
cess for a slave device is successful for all lines

Notify Error Host device that turns ON when the backup or restore pro-
cess for a slave device ends due to an error for any lines

Restore Mode Restore range of slave device for all lines
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●● Device

This shows the device that is set in System - LAN1/LAN2. It cannot be changed here.
•	Range: 	 Registered device
•	Default value: 	---

●● Backup Trigger

This sets the host device that serves as the trigger device for backing up the indi-
vidual configuration of a slave device.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Restore Trigger

This sets the host device that serves as the trigger device for restoring the individual 
configuration of a slave device.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Result

This sets the host device that transmits the execution results of Backup Configuration 
or Restore Configuration. Notify Result is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Complete

This sets the host device that turns ON when Backup Configuration or Restore 
Configuration is complete. Notify Complete is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Error

This sets the host device that turns ON when Backup Configuration or Restore 
Configuration ends due to an error. Notify Error is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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●● Restore Mode

This is used to select how much is restored when executing Restore Configuration. 
Mode restores NX loop mode (RUN/READY, AUTO/MANUAL, or RSP/LSP).

User-defined restores user-defined bits 1 to 32 and user-defined numerical values 1 
to 16.
•	Range: ‌�Parameter, 

Parameter + Mode, 
Parameter + User-defined, 
Parameter + Mode + User-defined

•	Default value: Parameter

 Note

•	“Parameter” in Restore Mode is identical to the target data when Read/Write 
Parameter is executed for the NX-SLP.

■■ Device Management - IP address assignment

This sets the assigning of IP addresses.

The attribute settings list includes the items below.

Parameter name Description

Host No. Host device that performs trigger determination and 
notification

IP Address Trigger Host device that assigns IP addresses to the connected slave 
devices (executed at ON)

Notify Result Host device that sends 0 when the IP address assignment 
process for the connected slave devices is successful. 
A failure code is sent if the process fails.

Notify Complete Host device that turns ON when the IP address assignment 
process for the connected slave devices is complete

Notify Error Host device that turns ON when the IP address assignment 
process for the connected slave devices ends due to an error

●● Host No.

The connected host device for assigning IP addresses is selected from the pull-
down menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● IP Address Trigger

This sets the host device that serves as the trigger device for executing IP address 
assignment. IP address assignment is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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●● Notify Result

This sets the host device that transmits the execution results of IP address assign-
ment. Notify Result is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Complete

This sets the host device that turns ON when IP address assignment is complete. 
Notify Complete is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Error

This sets the host device that turns ON when IP address assignment ends due to an 
error. Notify Error is not performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank
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■■ Device Management - Status Notification

This sets the status notification.

The attribute settings list includes the items below.

Parameter name Description

Host No. Host device that performs trigger determination and 
notification

Cyclic ON Notify Host device that turns ON for each cycle specified by 
the system for notifying that the NX-MGW is operating

Notify Connected Status Setting for whether status notification is sent to a bit 
device or is sent by specifying the bit position in the 
word device

●● Host No.

The connected host device for Status Notification is selected from the pull-down 
menu.
•	Range: 	 Selected from connected devices that were registered
•	Default value: 	---

●● Cyclic ON Notify

This sets the host device that performs transmission for Cyclic ON Notify. No noti-
fication is performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

●● Notify Connected Status

This sets whether status notification is sent in word units or by specifying the bit 
position by selecting from a pull-down menu.
•	Range: 	 Notify Bit, Notify Word
•	Default value: 	Notify Bit

The process settings list includes the items below.

Parameter name Description

Device (View only) Shows the slave device that is backed up or restored
Notify Disconnect Host device that turns ON when a disconnection occurs 

during execution of communication to a slave device
Bit Position Specifies the bit position from the least significant bit 

(LSB) of the word device when "Notify Word" is set
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●● Device

This shows the device that is set in System - LAN1/LAN2. This cannot be changed here.
•	Range: 	 Registered device
•	Default value: 	---

●● Notify Disconnect

This sets the host device that sends transmissions for Notify Disconnect. No notifi-
cation is performed if this is left blank.
•	Range: 	 Depends on the host device
•	Default value: 	Blank

 Note

•	If the “Notify Connected Status” is set to “Notify Word,” duplicate “Notify 
Disconnect” notifications can be set.

●● Bit Position

This sets which bit position of the word device is turned ON when “Notify 
Connected Status” is set to “Notify Word” in the attribute settings list. LSB is 0, and 
MSB is 15.
•	Range: 	 0 to 15
•	Default value: 	0
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When communicating with controllers made by Azbil and with PLCs, the NX-MGW acts as the host station for com-
munication, and communication messages are sent based on the communication protocol of the device that was set 
for LAN1/LAN2 by the SLP-MGW.

The host and slave devices send responses based on the communication messages sent by the NX-MGW.

This chapter describes the communication settings for the devices.
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6 - 1 	 Connected Device Models

■■ Connected device models

The devices that can be connected are shown in the table below.

Company name Series name Protocol TCP Name selected by

Azbil Network 
Instrumentation 
Modules

CPL/TCP TCP NX-D15

NX-D25

NX-D35

NX-DX

NX-DY
Mitsubishi Electric MELSEC iQ-R

MELSEC Q

MELSEC L

SLMP (3E) Binary TCP/UDP Mitsubishi SLMP (3E)

MELSEC iQ-F Mitsubishi iQ-F SLMP (3E)
Yokogawa Electric FA-M3 PC-Link Binary TCP/UDP Yokogawa FA-M3
Omron CJ

CS

FINS TCP/UDP Omron FINS

SIEMENS S7-1200

S7-300

S7-400

S7 communication COTP Siemens S7

JTEKT PC10 Computer Link 
PC10 mode

TCP TOYOPUC PC10 (TCP)

■■ General-purpose protocols

Protocol Transport layer Name selected by

Modbus/TCP Binary TCP/UDP Modbus-TCP
CPL/TCP TCP CPL-TCP

●● Available devices

The (data) address range for the available devices is shown below for each model.

●● Azbil

Device type Address range

Bit device 0.0 to 65535.F
Word device 0 to 65535
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●● Mitsubishi Electric

Device type Address range

Input relay X00000 to X0FFFF
Output relay Y00000 to Y0FFFF
Internal relay M00000 to M32766
Special relay SM00000 to SM02047
Link special relay SB00000 to SB01FFF
Edge relay V00000 to V02047
Latch relay L00000 to L08191
Link relay B00000 to B01FFF
Annunciator F00000 to F02047
Timer (contact) TS00000 to TS02047
Timer (coil) TC00000 to TC02047
Cumulative timer (contact) SS00000 to SS02047
Cumulative timer (coil) SC00000 to SC02047
Counter (contact) CS00000 to CS01023
Counter (coil) CC00000 to CC01023
Data register D0000000 to D4184063
Link register W000000 to W3FD7FF
Index register Z0000 to Z0015
File register (R) R00000 to R32767
File register (ZR) ZR00000 to ZR1042431
Special register SD00000 to SD02047
Link special register SW00000 to SW01FFF
Timer current value TN00000 to TN02047
Cumulative timer current value SN00000 to SN02047
Counter current value CN00000 to CN01023
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●● Yokogawa Electric

Device type Address range

Input relay Xlmmnn 
l: 	 unit number (0 to 7) 
mm: 	 slot position (1 to 16) 
nn: 	 terminal number (1 to 64)

Output relay Ylmmnn 
l: 	 unit number (0 to 7) 
mm: 	 slot position (1 to 16) 
nn: 	 terminal number (1 to 64)

Internal relay I00001 to I65536
Shared relay E00001 to E65536
Link relay L00001 to L65536
Special relay M00001 to M65536
Timer TU00001 to TU09999
Counter CU00001 to CU09999
Data register D00001 to D65536
Shared register R00001 to R65536
Index register V00001 to V65536
Link register W00001 to W65536
Special register Z00001 to Z65536
File register B00001 to B65536
Cache register F00001 to F65536
Timer setting TS00001 to TS09999
Timer current value TP00001 to TP09999
Timer current value (count up) TI00001 to TI09999
Counter setting CS00001 to CS09999
Counter current value CP00001 to CP09999
Counter current value (count up) CI00001 to CI09999

●● Omron

Device type Address range

Channel I/O bit 0000.00 to 6143.15
Internal auxiliary relay bit W000.00 to W511.15
Holding relay bit H000.00 to H1535.15
Special auxiliary relay bit A000.00 to A1471.15
Timer (up flag) T0000 to T4095
Counter (up flag) C0000 to C4095
Channel I/O 0000 to 6143
Timer (current value) TN0000 to TN4095
Counter (current value) CN0000 to CN4095
Data memory D00000 to D32767
Expansion data memory bank 0 E0_00000 to E0_32767

… …

Expansion data memory bank F EF_00000 to EF_32767
Expansion data memory bank 10 E10_00000 to E10_32767

… …

Expansion data memory bank 18 E18_00000 to E18_32767
Expansion data memory current E_00000 to E_32767
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●● SIEMENS

Device type Address range

Input bit I00000.0 to I65534.7
Output bit Q00000.0 to Q65534.7
Internal bit M00000.0 to M65534.7
Data bit DB00001.DBX00000.0 to DB60000.DBX65534.7
Input word IW00000 to IW65534
Output word QW00000 to QW65534
Internal word MW00000 to MW65534
Data word DB00001.DBW00000 to DB60000.DBW65534

●● TOYOPUC

Device type Address range

Keep relay Pn-K0000 to Pn-K02FF
Link relay Pn-L0000 to Pn-L07FF

Pn-L1000 to Pn-L2FFF
Internal relay Pn-M0000 to Pn-M07FF

Pn-M1000 to Pn-M17FF
Edge Pn-P0000 to Pn-P01FF

Pn-P1000 to Pn-P17FF
Timer/Counter Pn-T/C0000 to Pn-T/C01FF

Pn-T/C1000 to Pn-T/C17FF
Special relay Pn-V0000 to Pn-V00FF

Pn-V1000 to Pn-V17FF
Input/output relay Pn-X/Y0000 to Pn-X/Y07FF
Expansion edge EP0000 to EP0FFF
Expansion keep relay EK0000 to EK0FFF
Expansion special relay EV0000 to EV0FFF
Expansion timer/counter ET/C0000 to ET/C07FF
Expansion link relay EL0000 to EL1FFF
Expansion input/output EX/Y0000 to EX/Y07FF
Expansion internal relay EM0000 to EM1FFF
Expansion input/output GX/Y0000 to GX/YFFFF
Expansion internal relay GM0000 to GMFFFF
Data register Pn-D0000 to Pn-D2FFF
Timer/counter current value Pn-N0000 to Pn-N01FF

Pn-N1000 to Pn-N17FF
Link register Pn-R0000 to Pn-R07FF
Special register Pn-S0000 to Pn-S03FF

Pn-S1000 to Pn-S13FF
Expansion special register ES000 to ES07FF
Expansion current value 
register

EN0000 to EN07FF

Expansion setting register H0000 to H07FF
Expansion data register U00000 to U1FFFF
Expansion buffer register EB00000 to EB3FFFF
Flash register FR000000 to FR1FFFFF

*”Pn” of the address is PRG.1 to PRG.3
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6 - 2 	 Azbil Products

■■ Network Instrumentation Modules

This section gives an application example for the devices below.

Network Instrumentation Module NX-D25

Communication interface NX-CB2
Communication protocol TCP/IP, CPL

●● Device configuration

PLC
192.168.0.2

SLP-MGW
192.168.255.252

Network Instrumentation Modules

From the left
NX-CB2
NX-D25 192.168.0.20
NX-D25 192.168.0.21
NX-D25 192.168.0.22
NX-D25 192.168.0.23
NX-D25 192.168.0.24
NX-D25 192.168.0.25

NX-CB2

NX-MGW
LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

 Note

•	For details on the computer settings, see  4-6 Connection with NX-MGW.

●● SLP-MGW settings

(1) Set LAN1 to match the device configuration.  
Leave the settings for Read Device Max, Write Device Max, and Send Delay 
Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 
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Device IP address Port Retry-
count

Time-
out 

time

Enabled/
Disabled

Read Device 
Max

Write Device 
Max

Send 
Delay 
Time

Mitsubishi SLMP (3E) 192.168.0.2 1025 3 1000 Enabled 192 160 0
NX-D25 192.168.0.20 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.21 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.22 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.23 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.24 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.25 1252 3 1000 Enabled -- -- 10

●● Device settings

Use SLP-NX or SLP-MGW to assign the IP address.

 Handling Precautions

•	If a configuration backup of this device is made in a system configuration 
that includes a Network Instrumentation Module supervisor module, or 
in a system where the Data Transfer Between Modules function is set, the 
configuration will not be restored properly if the IP address of the Network 
Instrumentation Module is changed. Use the SLP-NX to apply changes in 
the IP address to the Network Instrumentation Module settings, and then 
back up the configuration again.

•	When a supernet setting (such as 255.255.0.0 for class C) is used for the 
subnet mask in the LAN settings, if the IP address assignment is run for the 
Network Instrumentation Modules, the setting using the SLP-NX can no 
longer be used.

•	In the NX-MGW, the mapping information for the Network Instrumentation 
Modules is not backed up, and so when the IP address assignment is ex-
ecuted, the chain name, workgroup ID, and node ID are set to the fixed 
values determined by the NX-MGW.

•	The workgroup ID and node ID are used in transfer operations between 
the Network Instrumentation Modules, and so if the ID values are changed 
to different values, problems will occur in transfer operations between the 
modules. For this reason, for the mapping settings of device configurations 
using transfer functions between Network Instrumentation Modules, be 
sure to use the settings below, which are the settings that are made when 
executing the IP address assignment of the NX-MGW.

Workgroup ID: 	 1

Node ID: 	 Sequential number starting from 1 in the assigned order
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6 - 3 	 PLCs by Mitsubishi Electric

This describes the communication settings for the Mitsubishi Electric Q series.

■■ CPU direct connection

This section gives an application example for the devices below.

PLC Q04UDEHCPU

Communication interface CPU with built-in Ethernet
Communication protocol TCP/IP, SLMP (3E) Binary Code

●● Device configuration

PLC
192.168.0.2

SLP-MGW
192.168.255.252

Network Instrumentation Modules

From the left
NX-CB2
NX-D25 192.168.0.20
NX-D25 192.168.0.21
NX-D25 192.168.0.22
NX-D25 192.168.0.23
NX-D25 192.168.0.24
NX-D25 192.168.0.25

NX-CB2

NX-MGW
LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

 Note

•	For details on the computer settings, see the connection with the 4-6NX-MGW.

●● SLP-MGW settings

(1) Set LAN1 to match the device configuration. Leave the settings for Read Device 
Max, Write Device Max, and Send Delay Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 
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Device IP address Port Retry-
count

Time-
out 

time

Enabled/
Disabled

Read Device 
Max

Write Device 
Max

Send 
Delay 
Time

Mitsubishi SLMP (3E) 192.168.0.2 1025 3 1000 Enabled 192 160 0
NX-D25 192.168.0.20 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.21 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.22 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.23 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.24 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.25 1252 3 1000 Enabled -- -- 10

●● Device settings

Use GX Developer to configure the settings as shown below.

(1) In Create New Project, select “Q04UDEHCPU” as the CPU model type to create 
the project.

(2) Double-click PC Parameter.

>> The Q Parameter Setting window opens.

(3) Select the Built-in Ethernet Port Setting tab, and configure the settings shown 
below. 

Item Setting

IP Address 192.168.0.2
Subnet Mask Pattern 255.255.255.0
Default Router IP Address Default
Communication Data Code Binary Code
Enable online change Select by inserting check mark
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(4) Click the [Open Setting] button.

>> The Built-in Ethernet Port Setting window opens.

(5) Make the port settings in the first row, and click the [End] button. 

Item Setting

Protocol TCP
Open System MC Protocol

>> The Q Parameter Setting window opens.

(6) Click the [End] button to close the window.

■■ Ethernet interface unit

This section gives an application example for the devices below.

PLC Q04UDEHCPU

Communication interface Ethernet interface unit QJ71E71-100
Communication protocol TCP/IP, SLMP (3E) Binary Code

●● Device settings

Use GX Developer to configure the settings as shown below.

(1) In Create New Project, select “Q04UDEHCPU” as the CPU model type to create 
the project.

(2) Double-click Network Parameter.

>> The Network Parameter Selection window opens.

(3) Click the [Ethernet/CC IE/MELSECNET] button.

>> The Network Parameter Ethernet/CC IE/MELSECNET Sheet Quantity Setting 
window opens.

(4) Set the “Start I/O No.,”, “Network No.,” and Station No.” based on your 
configuration.
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(5) Click the [Operation Setting] button in the table.

>> The Ethernet Operation Setting window opens. 

(6) Set the items, and click the [End] button.

Item Setting

Communication Data Code Binary Code
Initial Timing Always wait for OPEN (Communication 

possible at STOP time)
Input Format DEC (Decimal)
IP Address Setting 192.168.0.2
Send Frame Setting Ethernet (V2.0)
TCP Existence Confirmation Setting Use the KeepAlive
Enable Online Change Select by inserting check mark

>> The Network Parameter Ethernet/CC IE/MELSECNET Sheet Quantity Setting 
window opens.

(7) Click the [Open Setting] button in the table.

>> The Network Parameter Ethernet Port Open Setting window opens.
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(8) Configure the port settings in the first row. 

Item Setting value

Protocol TCP
Open System Unpassive
Fixed Buffer Update Procedure Exist
Pairing Open Enable
Existence Confirmation Confirm
Host Station Port No. 1025
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6 - 4 	 PLCs by Yokogawa Electric

This section describes the communication settings for the Yokogawa Electric FA-M3 series.

■■ CPU direct connection

This section gives an application example for the devices below.

PLC F3SP71-4S

Communication interface CPU module with built-in Ethernet
Communication protocol TCP/IP, Binary format

●● Device configuration

PLC
192.168.0.2

SLP-MGW
192.168.255.252

Network Instrumentation Modules

From the left
NX-CB2
NX-D25 192.168.0.20
NX-D25 192.168.0.21
NX-D25 192.168.0.22
NX-D25 192.168.0.23
NX-D25 192.168.0.24
NX-D25 192.168.0.25

NX-CB2

NX-MGW
LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

 Note

•	For details on the computer settings, see the connection with the 4-6 NX-MGW.

●● SLP-MGW settings

(1) Set LAN1 to match the device configuration.  
Leave the settings for Read Device Max, Write Device Max, and Send Delay 
Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 
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Device IP Address Port Retry-
count

Time-
out 

time

Enabled/
Disabled

Read Device 
Max

Write Device 
Max

Send 
Delay 
Time

Yokogawa FA-M3 192.168.0.2 12289 3 1000 Enabled 32 32 0
NX-D25 192.168.0.20 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.21 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.22 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.23 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.24 1252 3 1000 Enabled -- -- 10
NX-D25 192.168.0.25 1252 3 1000 Enabled -- -- 10

●● Device settings

Use WideField3 to configure the settings as shown below.

(1) In Create New Project, select [F3SP71-4S] as the CPU model type to create the 
project.

(2) In the CPU properties, select the file “f3sp71-4s.yprp.”

>> First, the setting for [LOAD] appears in the right-side pane. Leave the setting for 
LOAD at its default value.

(3) Select [ETHERNET], and set the IP address. 

Item Setting

ETHER_MY_IPADDRESS 192.168.0.2
ETHER_SUBNET_MASK 255.255.255.0
ETHER_DEFAULT_GATEWAY 0.0.0.0
ETHER_PRIMARY_DNS 0.0.0.0
ETHER_SECONDARY_DNS 0.0.0.0
ETHER_MY_HOST_NAME FAM3
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(4) Select [HIGHER-LEVEL_LINK_SERVICE], and set the command data format.

Item Setting

HLLINK_PROTOCOL_A 0 (TCP/IP)
HLLINK_DATA_FORMAT_A 1 (Binary format)
HLLINK_PROTOCOL_B Not used
HLLINK_DATA_FORMAT_B Not used
HLLINK_PROTECT 0 (Write enabled)

 Note

•	The number of port A of FA-M3 is 12289. Thenumber of port B is 12291.



6-16

Chapter 6.	 DEVICE COMMUNICATION SETTINGS

6 - 5 	 Omron PLCs

Communication settings for the Omron CJ series are described here.

■■ Ethernet unit connection

This section gives an application example for the devices below.

PLC CJ2H

Communication interface Ethernet unit (CJ1W-ETN21)
Communication protocol FINS

●● Device configuration

PLC
192.168.0.2

SLP-MGW
192.168.255.252

Network Instrumentation Modules

From the left
NX-CB2
NX-D25 192.168.0.20
NX-D25 192.168.0.21
NX-D25 192.168.0.22
NX-D25 192.168.0.23
NX-D25 192.168.0.24
NX-D25 192.168.0.25

NX-CB2

NX-MGW
LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

 Note

•	For details on the computer settings, see  4-6 Connection with NX-MGW.

●● SLP-MGW settings

(1) ‌�Set LAN1 to match the device configuration.  
Leave the settings for Read Device Max, Write Device Max, and Send Delay 
Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 
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Device IP Address Port Transport layer 
protocol Option 1 Option 2 Read Device 

Max
Write 

Device Max
Send Delay 

Time

Omron FINS 192.168.0.2 9600 TCP 1 0 167 167 0
NX-D25 192.168.0.20 1252 --- --- --- -- -- 10
NX-D25 192.168.0.21 1252 --- --- --- -- -- 10
NX-D25 192.168.0.22 1252 --- --- --- -- -- 10
NX-D25 192.168.0.23 1252 --- --- --- -- -- 10
NX-D25 192.168.0.24 1252 --- --- --- -- -- 10
NX-D25 192.168.0.25 1252 --- --- --- -- -- 10

Option 1: FINS node number of PLC.

Option 2: FINS node number of NX-MGW. For TCP, the PLC performs automatic number assignment with the “0” setting.

●● Device settings

Use CX-Programmer to configure the settings as shown below.

(1) Open the PLC IO Table screen from the Project screen.

 

(2) Double-click the Ethernet unit.

>> The Ethernet Unit CPU High Functionality Unit Setting window opens. 

(3) Set the items, and click the [OK] button.

Item Setting

IP Address 192.168.0.2
Sub-net Mask 255.255.255.0
FINS/UDP Port Default (9600)
Node Number 2 (set by the rotary switch on the Ethernet unit)
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6 - 6 	 Siemens PLCs

Communication settings for the Siemens S7 series are described here.

■■ CPU direct connection

This section gives an application example for the devices below.

PLC S7-1200

Communication interface CPU module with built-in Ethernet
Communication protocol S7 protocol (TCP/IP)

●● Device configuration

PLC
192.168.0.2

SLP-MGW
192.168.255.252

Network Instrumentation Modules

From the left
NX-CB2
NX-D25 192.168.0.20
NX-D25 192.168.0.21
NX-D25 192.168.0.22
NX-D25 192.168.0.23
NX-D25 192.168.0.24
NX-D25 192.168.0.25

NX-CB2

NX-MGW
LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

 Note

•	For details on the computer settings, see  4-6 Connection with NX-MGW.

●● SLP-MGW settings

(1) ‌�Set LAN1 to match the device configuration.  
Leave the settings for Read Device Max, Write Device Max, and Send Delay 
Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 
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Device IP Address Port Transport layer 
protocol Option 1 Option 2 Read 

Device Max
Write 

Device Max
Send Delay 

Time

Siemens S7 192.168.0.2 102 --- 0 1 --- --- 0
NX-D25 192.168.0.20 1252 --- --- --- -- -- 10
NX-D25 192.168.0.21 1252 --- --- --- -- -- 10
NX-D25 192.168.0.22 1252 --- --- --- -- -- 10
NX-D25 192.168.0.23 1252 --- --- --- -- -- 10
NX-D25 192.168.0.24 1252 --- --- --- -- -- 10
NX-D25 192.168.0.25 1252 --- --- --- -- -- 10

Option 1: CPU rack number

Option 2: CPU slot number

●● Device settings

Use STEP7 (Totally Integrated Automation Portal) to configure the settings below.

(1) In Create New Project, create a project for the S7-1200.

(2) ‌�In the CPU properties, select “Ethernet addresses.”

>> First, the setting value appears on the right side.

(3) Configure the settings for “IP protocol.”

Item Setting

IP address 192.168.0.2
Subnet mask 255.255.255.0

The rack number of the S7-1200 is fixed at “0.”

For the slot number, refer to the value for Device configuration of the CPU. 
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 Note

•	The typical communication error codes are shown below. 

Code Description Resolution method

0x05 Accessed an address that is outside 
the range

Check the specified address range.

0x0A Attempted to access a nonexistent 
data block

Check whether the specified data 
block exists.
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6 - 7 	 JTEKT PLCs

Communication settings for the JTEKT PC10 series are described here.

■■ CPU connection

This section gives an application example for the devices below.

PLC PC10G

Communication interface CPU module with built-in Ethernet
Communication protocol Computer Link PC10 mode

●● Device configuration

PLC
192.168.0.2

SLP-MGW
192.168.255.252

Network Instrumentation Modules

From the left
NX-CB2
NX-D25 192.168.0.20
NX-D25 192.168.0.21
NX-D25 192.168.0.22
NX-D25 192.168.0.23
NX-D25 192.168.0.24
NX-D25 192.168.0.25

NX-CB2

NX-MGW
LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

 Note

•	For details on the computer settings, see  4-6 Connection with NX-MGW.

●● SLP-MGW settings

(1) Set LAN1 to match the device configuration.  
Leave the settings for Read Device Max, Write Device Max, and Send Delay 
Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 
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Device IP Address Port Transport layer 
protocol Option 1 Option 2 Read 

Device Max
Write 

Device Max
Send Delay 

Time

TOYOPUC 
PC10 (TCP)

192.168.0.2 1025 --- --- --- --- --- 0

NX-D25 192.168.0.20 1252 --- --- --- --- --- 10
NX-D25 192.168.0.21 1252 --- --- --- --- --- 10
NX-D25 192.168.0.22 1252 --- --- --- --- --- 10
NX-D25 192.168.0.23 1252 --- --- --- --- --- 10
NX-D25 192.168.0.24 1252 --- --- --- --- --- 10
NX-D25 192.168.0.25 1252 --- --- --- --- --- 10

●● Device settings

Use PCwin to configure the settings as shown below.

(1) From the Project screen, open [Parameter] → [Link Parameter].  
>> The Link Parameter Setup window opens.

(2)  Click the [Link setup (S)] button.  
>> The Link Setup window opens.

Configure the settings for the link module.
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(3) Click [Detail (D)] in the Link Parameter Setup window.  
>>The Ethernet Setup window opens.

(4) Set the items, and click the [OK] button.

Item Setting

IP Address 192.168.0.2
Open Protocol TCP Destination Non-Specified Passive Open
Own Node Port. No. 1025
Initialize Initialized based on Link Parameter
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6 - 8 	 Modbus

This describes the communication settings for Modbus.

■■ TCP/IP

This section gives an application example for Modbus TCP/IP devices.

●● Device configuration

192.168.255.252
SLP-MGW

192.168.0.2

NX-MGW

LAN1=192.168.0.127
LAN2=192.168.4.127/192.168.255.253

Switching hub

RESETV-
12-48V

V+ LAN2LAN1

Ready

TX

RX
P1

TX

RX
P2

P1 P2
RS-232/422/485

1 2

Modbus 
host device

192.168.0.20 

Modbus 
slave device

 Note

•	For details on the computer settings, see  4-6 Connection with NX-MGW.

●● SLP-MGW settings

(1) ‌�Set LAN1 to match the device configuration.  
Leave the settings for Read Device Max, Write Device Max, and Send Delay 
Time unchanged at the default values.

(2) Leave LAN2 unchanged at the default value. 

Device IP Address Port Transport layer 
protocol Option 1 Option 2 Read 

Device Max
Write 

Device Max
Send Delay 

Time

Siemens S7 192.168.0.2 502 --- 1 0 125 123 0
NX-D25 192.168.0.20 502 --- 1 1 125 123 0

Option 1: Set the slave ID of the Modbus device.
	 Default value: 1
	 Setting range: 0 to 255
Option 2: This specifies the function (Func) number used for writing.

0: Writing of multiple coils and general-purpose registers (using Func15 and Func16)
1: Writing of one coil and multiple general-purpose registers (using Func5 and Func16)
2: Writing of multiple coils and one general-purpose register (using Func15 and Func6)
3: Writing of one coil and one general-purpose register (using of Func5 and Func6)

	 Default value: 0
	 Setting range: 0 to 3
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■■ NX-MGW Hardware Specifications (UC-7112-LX Plus by Moxa)

Item Specifications

LAN interface 
communication 
specifications

No. of ports 2 (LAN1, LAN2)
Transmission format IEEE802.3 

10BASE-T/100BASE-TX 
(with auto-negotiation and AutoMDI/MDI-X function)

Connector RJ-45
Cable 100BASE-TX cable 

UTP cable (4P) Cat 5e or higher (straight) (ANSI/TIA/EIA-568B, both ends), 
maximum length: 100 m

LED System OS Ready × 1
LAN 10M/Link × 2, 100M/Link × ２ (located on connector)

Physical 
characteristics

Housing Aluminum
Weight 190 g
Dimensions 77×111×26 mm
Mounting method DIN rail (using DIN rail mounting kit) 

Wall (screw-mounted)
Operating 
environment

Ambient temperature -10 °C to +60 °C
Ambient humidity 5 % to 95 % RH (no condensation)
Allowable operating power 
voltage

12 to 48 V DC

Transportation 
and storage 
requirements

Ambient temperature -20 °C to +80 °C

Other Power consumption 4.5 W
Standards and 
certifications

EMC CE (EN 55022 Class A, EN 61000-3-2 Class A, EN 61000-3-3, EN 55024) 
FCC (Part 15 Subpart B, CISPR 22 Class A)

Safety standards UL/cUL (UL 60950-1, CSA C22.2 No. 60950-1-03)
Power adapter Ambient temperature 0 °C to 40 °C

Ambient humidity 20 % to 95 % RH (without condensation)
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■■ Dimensions

� Units: mm

Φ6

Φ4

26

Φ7

100

88

77

47.3

21.3

12.5

11
1

25



8-1

Chapter 8.	 Troubleshooting

■■ Diagnosing by the status of the indicators

Problems in the NX-MGW can be diagnosed using the indicators.

●● Ready LED

Status Meaning Corrective action

Off NX-MGW power is off The NX-MGW is starting up. 
Wait until the startup process is complete.

Flashing 
green

Slow flashing: Initializing This is normal operation. 
Wait until the initialization process is complete.

Rapid flashing: Initializing Operation has stopped due to a system error. 
A hardware failure has occurred. Please use a replacement.
Operation has stopped due to a setting error. 
Normally, invalid settings cannot be written from the SLP-MGW, but 
the configuration file may have been corrupted. 
Try writing the settings from the SLP-MGW again.

Lit green NX-MGW power is on Normal operation
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●● Result codes

Function Result 
code Description Corrective action

Backup and 
Restore 
shared codes

86 File is corrupted The backed-up file was corrupted. 
Perform the backup process again.

87 Failed to obtain device version Among the connected Network Instrumentation 
Modules there is an old version that is not compatible 
with Backup Restore. 
Check the versions.

88 Model number mismatch The settings do not match the connected Network 
Instrumentation Module. 
Check the system configuration.

89 Unsupported version Among the connected Network Instrumentation 
Modules there is an old version that is not compatible 
with Backup Restore. 
Check the versions.

90 Unable to read file The backed-up file was not found. 
Perform the backup process again.

91 Failed to connect to device A communication error occurred. 
Check the connections and system configuration.92 Error in communication with device

93 Receiving of data failed
Backup 94 Saving of data failed Saving of the file failed. 

A hardware failure is possible. 
Please use a replacement.

Restore 94 Error response received from device A communication error occurred. 
Check the connections and system configuration.

95 Backup file is too large A portion of the connected Network Instrumentation 
Modules may have failed. 
Check the system configuration.

IP address 
numbering

86 Too many Network Instrumentation 
Modules

The maximum number of connected Network 
Instrumentation Modules is 31. 
Check the system configuration.

87 Local IP address does not match A device in the wrong segment was found at the IP ad-
dress setting of the Network Instrumentation Module by 
the SLP-MGW. 
Please correct the settings.

88 Socket error occurred An internal error occurred. 
Turn the power for the NX-MGW off and then on again.

89 Canceled Operation of the loader was canceled before completion. 
Perform the loader operation again.

91 Number of devices does not match The number of Network Instrumentation Modules set by 
the SLP-MGW does not match the actual number of con-
nected modules. 
Please correct the settings.

92 Connected device information could 
not be obtained.

A communication error occurred. 
Check the connections and system configuration.

93 Number of devices does not match 
(device comparison)

An IP address mismatch was found in the check after ex-
ecuting IP address assignment. 
A portion of the connected Network Instrumentation 
Modules may have failed. 
Check the system configuration.
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EU

When disposing of this device, remove the internal battery, and dispose of it appropriately in accordance with local 
regulations.

■■ Battery removal procedure

(1) Remove the two screws on both sides of the device.

(2) Slide the cover off to remove it.

(3) The battery is soldered to the circuit board. Use a pair of nippers or other tool to 
cut the lead wire, and remove the battery. 

 Handling Precautions
•	Never remove the battery from this device except when disposing of this device.
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Terms and Conditions
We would like to express our appreciation for your purchase and use of Azbil Corporation's products. 
You are required to acknowledge and agree upon the following terms and conditions for your purchase of Azbil Corporation's 
products (system products, field instruments, control valves, and control products), unless otherwise stated in any separate 
document, including, without limitation, estimation sheets, written agreements, catalogs, specifications and instruction manuals. 

1.	 Warranty period and warranty scope
1.1	 Warranty period

Azbil Corporation's products shall be warranted for one (1) year from the date of your purchase of the said products or 
the delivery of the said products to a place designated by you.

1.2	 Warranty scope
In the event that Azbil Corporation's product has any failure attributable to azbil during the aforementioned warranty 
period, Azbil Corporation shall, without charge, deliver a replacement for the said product to the place where you 
purchased, or repair the said product and deliver it to the aforementioned place. 
Notwithstanding the foregoing, any failure falling under one of the following shall not be covered under this warranty: 

(1)	 Failure caused by your improper use of azbil product  
(noncompliance with conditions, environment of use, precautions, etc. set forth in catalogs, specifications, 
instruction manuals, etc.); 

(2)	 Failure caused for other reasons than Azbil Corporation's product;
(3)	 Failure caused by any modification or repair made by any person other than Azbil Corporation or Azbil 

Corporation's subcontractors;  
(4)	 Failure caused by your use of Azbil Corporation's product in a manner not conforming to the intended usage of 

that product; 
(5)	 Failure that the state-of-the-art at the time of Azbil Corporation's shipment did not allow Azbil Corporation to 

predict; or 
(6)	 Failure that arose from any reason not attributable to Azbil Corporation, including, without limitation, acts of God, 

disasters, and actions taken by a third party. 
Please note that the term “warranty” as used herein refers to equipment-only-warranty, and Azbil Corporation shall not 
be liable for any damages, including direct, indirect, special, incidental or consequential damages in connection with or 
arising out of Azbil Corporation's products. 

2.	 Ascertainment of suitability 
You are required to ascertain the suitability of Azbil Corporation's product in case of your use of the same with your 
machinery, equipment, etc. (hereinafter referred to as “Equipment”) on your own responsibility, taking the following 
matters into consideration: 

(1)	 Regulations and standards or laws that your Equipment is to comply with.
(2)	 Examples of application described in any documents provided by Azbil Corporation are for your reference 

purpose only, and you are required to check the functions and safety of your Equipment prior to your use. 
(3)	 Measures to be taken to secure the required level of the reliability and safety of your Equipment in your use 

Although azbil is constantly making efforts to improve the quality and reliability of Azbil Corporation's 
products, there exists a possibility that parts and machinery may break down. 
You are required to provide your Equipment with safety design such as fool-proof design, *1 and fail-safe 
design*2 (anti-flame propagation design, etc.), whereby preventing any occurrence of physical injuries, fires, 
significant damage, and so forth. Furthermore, fault avoidance, *3 fault tolerance,*4 or the like should be 
incorporated so that the said Equipment can satisfy the level of reliability and safety required for your use. 

*1. A design that is safe even if the user makes an error. 
*2. A design that is safe even if the device fails. 
*3. Avoidance of device failure by using highly reliable components, etc. 
*4. The use of redundancy. 

3.	 Precautions and restrictions on application 
Azbil Corporation's products other than those explicitly specified as applicable (e.g. azbil Limit Switch For Nuclear Energy) 
shall not be used in a nuclear energy	controlled area (radiation controlled area). 
Any Azbil Corporation's products shall not be used for/with medical equipment. 
The products are for industrial use. Do not allow general consumers to install or use any Azbil Corporation's product. 
However, azbil products can be incorporated into products used by general consumers. If you intend to use a product for 
that purpose, please contact one of our sales representatives. 
In addition, 
you are required to conduct a consultation with our sales representative and understand detail specifications, cautions 
for operation, and so forth by reference to catalogs, specifications, instruction manual, etc. in case that you intend to use 
azbil product for any purposes specified in (1) through (6) below. 
Moreover, you are required to provide your Equipment with fool-proof design, fail-safe design, anti-flame propagation 
design, fault avoidance, fault tolerance, and other kinds of protection/safety circuit design on your own responsibility to 
ensure reliability and safety, whereby preventing problems caused by failure or nonconformity. 

(1)	 For use under such conditions or in such environments as not stated in technical documents, including catalogs, 
specification, and instruction manuals 

(2) 	For use of specific purposes, such as: 
*	� Nuclear energy/radiation related facilities  

[For use outside nuclear energy controlled areas] [For use of Azbil Corporation's Limit Switch For Nuclear 
Energy] 

*	 Machinery or equipment for space/sea bottom 
*	 Transportation equipment 
	 [Railway, aircraft, vessels, vehicle equipment, etc.] 
*	 Antidisaster/crime-prevention equipment 



*	 Burning appliances 
*	 Electrothermal equipment 
* 	Amusement facilities 
*	 Facilities/applications associated directly with billing 

(3)	 Supply systems such as electricity/gas/water supply systems, large-scale communication systems, and traffic/air 
traffic control systems requiring high reliability 

(4)	 Facilities that are to comply with regulations of governmental/public agencies or specific industries 
(5)	 Machinery or equipment that may affect human lives, human bodies or properties 
(6)	 Other machinery or equipment equivalent to those set forth in items (1) to (5) above which require high reliability 

and safety 

4.	 Precautions against long-term use 
Use of Azbil Corporation's products, including switches, which contain electronic components, over a prolonged period 
may degrade insulation or increase contact-resistance  and may result in heat generation or any other similar problem 
causing such product or switch to develop safety hazards such as smoking, ignition, and electrification.
Although acceleration of the above situation varies depending on the conditions or environment of use of the products, 
you are required not to use any  Azbil Corporation's products for a period exceeding ten (10) years unless otherwise 
stated in specifications or instruction manuals. 

5.	 Recommendation for renewal
Mechanical components, such as relays and switches, used for Azbil Corporation's products will reach the end of their life 
due to wear by repetitious open/close operations. 
In addition, electronic components such as electrolytic capacitors will reach the end of their life due to aged deterioration 
based on the conditions or environment in which such electronic components are used.
Although acceleration of the above situation varies depending on the conditions or environment of use, the number of 
open/close operations of relays, etc.  as prescribed in specifications or instruction manuals, or depending on the design 
margin of your machine or equipment, you are required to renew any Azbil Corporation's products every 5 to 10 years 
unless otherwise specified in specifications or instruction manuals.
System products, field instruments (sensors such as pressure/flow/level sensors, regulating valves, etc.) will reach the end 
of their life due to aged deterioration of parts.
For those parts that will reach the end of their life due to aged deterioration, recommended replacement cycles are 
prescribed. You are required to replace parts based on such recommended replacement cycles. 

6.	 Other precautions
Prior to your use of Azbil Corporation's products, you are required to understand and comply with specifications (e.g., 
conditions and environment of use), precautions, warnings/cautions/notices as set forth in the technical documents 
prepared for individual Azbil Corporation's products, such as catalogs, specifications, and instruction manuals to ensure 
the quality, reliability, and safety of those products. 

7.	 Changes to specifications 
Please note that the descriptions contained in any documents provided by azbil are subject to change without notice for 
improvement or for any other reason.
For inquires or information on specifications as you may need to check, please contact our branch offices or sales offices, 
or your local sales agents. 

8.	 Discontinuance of the supply of products/parts
Please note that the production of any Azbil Corporation's product may be discontinued without notice. 
For repairable products, we will, in principle, undertake repairs for five (5) years after the discontinuance of those 
products. In some cases, however, we cannot undertake such repairs for reasons, such as the absence of repair parts.
For system products, field instruments,  we may not be able to undertake parts replacement for similar reasons. 

9.	 Scope of services 
Prices of Azbil Corporation's products do not include any charges for services such as engineer dispatch service. 
Accordingly, a separate fee will be charged in any  of the following cases: 

(1)	 Installation, adjustment, guidance, and attendance at a test run 
(2)	 Maintenance, inspection, adjustment, and repair
(3)	 Technical guidance and technical education 
(4)	 Special test or special inspection of a product under the conditions specified by you

Please note that we cannot provide any services as set forth above in a nuclear energy controlled area (radiation 
controlled area) or at a place where the level of exposure to radiation is equivalent to that in a nuclear energy controlled 
area. 

� AAS-511A-014-09
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